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1 System requirements for running the xTIMEcomposer

The xTIMEcomposer tools are officially supported on the following platforms:
HI; ' Windows XP SP3
32-bit with 32-bit JRE
Windows 7 SP 1
32-bit with 32-bit JRE
64-bit with 32-bit JRE
Windows 8
32-bit with 32-bit JRE
64-bit with 32-bit JRE
Windows 10
32-bit with 32-bit JRE
64-bit with 32-bit JRE
Mac OS X 10.6 +
Intel Processors
& Linux CentOS 5.8 and Ubuntu 12.04 LTS
32-bit with 32-bit JRE
64-bit with 64-bit JRE

The tools also work on many other versions of Linux, including RedHat and Ubuntu.
For up-to-date information on known compatibility issues, see:

» http://www.xmos.com/tools

You must also have a Java Runtime Environment (JRE) version 1.5 or later installed,
which can be downloaded from:

» http://java.sun.com/javase/downloads
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2 Installation Instructions

IN THIS CHAPTER
Install the tools

Install the USB drivers

XTIMEcomposer and related drivers are provided in a single platform-specific
downloadable file.

2.1 Install the tools
To install the tools on your PC, follow these steps:

/s'I; / On Windows:
1. Download the Windows installer from:
» http://www.xmos.com/tools

2. Double-click the installer to run it. Follow the on-screen prompts to install the
tools on your PC.

On Mac:

1. Download the Macintosh installer from:
» http://www.xmos.com/tools

2. Double-click the downloaded installer to open it, and then drag the xTIMEcom-
poser icon into your Applications folder.

The installer copies the files to your hard disk.
3. Unmount the installer.

& On Linux:

1. Download the Linux archive from:
» http://www.xmos.com/tools

2. Uncompress the archive to an installation directory, for example by entering
the following command:
» tar -xzf archive.tgz -C /home/user
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2.2 Install the USB drivers

Figure 1:
Adapter con-
figurations
used with
xCORE
development
boards

"]
Kli 7

xTIMEcomposer interfaces to development boards over USB. Some boards provide
a completely integrated debugger with the xCORE device, while others require an
external xTAG adapter that connects to the board via an XSYS connector.

(7 3
(@) (@)
XCORE [
device [
] Wlth e COnL:]SE!EtDI'
1 integrated F
1 debugger [
\o o/
(7 N
(@) (@)
E XTAG
xCORE | g USB
device [ External |connector
F adapter -
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Consult your board manual to determine which driver to use.
On Windows:

The JTAG drivers are installed by the tools installer. Plug your xCORE development
board in after an installation to load the drivers.

On Mac:
USB driver support is provided natively on OS X.
On Linux:

USB driver support is provided natively on some versions of Linux. In some cases
the driver must be enabled, see Enable USB drivers on Linux'

"http://www.xmos . com/published/enable-usb-drivers-1linux

XMOS
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3 Get started with xTIMEcomposer

IN THIS CHAPTER

Start xTIMEcomposer Studio

Start the command-line tools

Welcome window

Perspective icons

Help Perspective

3.1 Start xTIMEcomposer Studio

-/
“{ y

To start xTIMEcomposer Studio:

In Windows:

Choose Start » Programs » XMOS » xTIMEcomposer_14 » xtimecomposer.
In OS X:

Open a new Finder window, navigate to the Applications folder, open the folder
XMOS_xTIMEcomposer_14 and double-click on the xtimecomposer.app icon.

In Linux:

Open a terminal window, change to the installation directory and enter the following
commands:

» source SetEnv

» xtimecomposer

3.1.1 Register xTIMEcomposer

The first time you start xTIMEcomposer Studio, you are required to register the
tools with your XMOS account so you must be connected to the internet.

Once you have registered xTIMEcomposer you can use the tools offline although we
recommend that you remain connected as often as possible in order to download
the latest versions of software and documentation.

Registration provides benefits such as automatic notifications of document and

software updates directly within the Studio, and the option to manage account
settings from within the tools.

XMOS
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[ ] xTIMEcomposer Studic Registration

° Sign in (online) using your xmos.com credentials

Username: ||
Password:

Having Problems Registering?

Sign in {offline) using your tools key

Tools Key:
Figure 2: Can't find your tools key?
XTIMEcomposer
Studio
registration Exit
window

If you have problems registering, click the Having problems registering link in
the xTIMEcomposer Studio Registration window. This window has four options to

help you get started:

Forgotten your password - Opens a page on the xmos.com website that you

can use to request a new password.

Configure the proxy server settings - Opens the system Network Connections
window so you can configure your proxy settings.

Disable security certificate checking - Opens the xTIMEcomposer Preferences
window where you can disable security certificate checking.

You can also sign into the tools using the Sign in using your tools key option
if you have no internet connection. Your tools key is emailed to you when you
register on xmos.com. It can also be found on the Account tab of your MyXMOS

account.

aeelV\ag REFERENCE SOFTWARE  DESIGN ADVISORIES  SUBSCRIPTIONS

Welcome
Figure 3: LTooIs Key:
MyXMOS Email:
Account:
Tools Key Password: *** change
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3.2 Start the command-line tools

e
I

"/
!I{/

The xTIMEcomposer command-line tools use a set of environment variables when
searching for header files, libraries and target devices (see §10.8). To add the
XTIMEcomposer tools to the path and configure the default set of environment
variables:

In Windows:
Choose Start » Programs » XMOS » xTIMEcomposer_14 » Command Prompt.
In OS X:

Open a Terminal window, change to the installation directory and enter the follow-
ing command:

» SetEnv.command
In Linux:

Open a Terminal window, change to the installation directory and enter the follow-
ing command:

» source SetEnv

You can now run any of the tools by entering its name and command-line options.
Some of the most common commands are summarized in the following section.

XMO0980TA

XMOS



xTIMEcomposer User Guide for tools version 14.0.x 21/412

3.3 Welcome window
The Welcome window in xTIMEcomposer Studio provides a convenient starting
point for all users, including developers who are new to XMOS and experienced
users.

XT XMOS Welcome 53 =ie,

Welcome to xTIMEcomposer Studio
WHAT'S NEW in 14.0.0? reLeast NOTES & COMPATIBILITY

= Development support for xCORE-200 products
= Compiler, debugger, simulator, XTA support for new architecture
features including dual issue code
= XTAG firmware support for JTAG interface

= Support for eXplorerKIT and xCORE-200 Audio MC boards

Improved error reporting for runtime exceptions in application code

Improved memory usage across entire application

XTIMEcomposer Studio

- Navigation bar for easy access to new development perspectives: Edit,
Analyze, Debug, Trace, Examples, Help

- Task viewer displays distribution of tasks; Binary viewer displays

XTIMEcomposer PERSPECTIVES

Switch between common tasks using the PERSEPECTIVE icons:

7 Project Explorer, Editing View, and Libraries Browser
which lists available software libraries

Binary Analyzer for binary analysis, and XMOS Timing
Analyser for timing analysis and timing closure

Debugger with support for all xCORE multicore
microcontrollers

VCD Tracing, xSCOPE (offline and real-time), Simulator
tracing and GProf Profiling

Examples Browser with a list of application notes and
executable examples that you can drag into your project

Tools and Programming Guides; live feeds from the
XCore Community website and ticketing system

compiled binary information e (Enterprise only)
- Library and Examples browsers to access libraries and app notes
- Integration with XCore.com Community support and XMOS Enterprise GET STARTED

ticketing system

- Integration with Eclipse marketplace 1. Go to the Examples Browser

2. Select the Getting Started with the xTIMEcomposer Studio (AN00190)
example at the top of the list.

Figure 4:

XFLASH: QUAD SPI programming support

XTI M ECOI’TI poser = XBURN and XFLASH compress binary data stored in OTP or Flash 3, Read the full application note and import the software
Studio = XFLASH supports arbitrary networks
Welcome
window

Developers with an xCORE development board, can use the page to check their
board is working correctly, download firmware and find kit-specific documentation
or tutorials. Those who do not have a board you can follow a tools tutorial using the
simulator or download xTIMEcomposer related documentation and programming
guides.

In XTIMEcomposer Studio, choose Help » Welcome to view the Welcome window
at any time.

XMOS
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3.4 Perspective icons

The Eclipse interface has been updated to make it easier to switch between common
tasks using the perspective icons displayed on the left of the xTIMEcomposer
window.

EDIT: Project Explorer, Editing View, and Libraries Browser which lists available
software libraries.

ANALYZE: Binary Analyzer for binary analysis, and XMOS Timing Analyzer for
timing analysis and timing closure.

DEBUG: Debugger with support for all xCORE multicore microcontrollers.

TRACE: VCD Tracing, xSCOPE (offline and real-time), Simulator tracing and GProf
Profiling.

EXAMPLES: Examples Browser with a list of application notes and executable
examples that you can drag into your project.

HELP: Tools and Programming Guides; live feeds from the XCore Community
website and ticketing system (Enterprise only).

EEEERE

3.5 Help Perspective

The xTIMEcomposer Help Perspective contains a web bowser that displays all
the information developers need when writing real-time multicore applications,
including:
a live view of the XMOS website (xmos.com), allowing users to download the
latest documentation from within the development tools, as well as managing
their XMOS account;

a live link to the XCore Community Q&A website (Community tools) or XMOS
Ticketing system (Enterprise Tools).

&% Help 2 & Community Support 3

XMOS XCore Home Blog Q&A Forum GitHub Projects Search SignIn Join

Tools and Progamming Guides

Figure 5: ' ‘ Jser Sulce {1 POR) Keyword Search
XTIMEcomposer e =
Studio Help l Tags Resolved Unresolved Unanswered
Perspective SortBy: Newest TopVoted Top Answered Top Viewed

Developers navigate the content using the toolbar, which provides the following
options:

¥ Home loads the default Developer Column home page that displays content related
to the tools, development boards and silicon devices.
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Local Home loads the home page for xTIMEcomposer and programming content
that has been downloaded and stored offline using the Update offline content
option.

Back and Forward navigate between the next and previous web pages in the
Developer Column.

Refresh reloads the current web page.

Update offline content downloads to your local drive the documentation for xTIME-
composer and programming C applications so they can be used in the Developer
Column when xTIMEcomposer is offline.

The Developer Column can be displayed at any time using Window » Show View
» Developer Column.

XMO0980TA
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4 Frequently used commands

IN THIS CHAPTER
XCC
XRUN
XGDB
XSIM

This document summarizes a number of frequently-used commands that can be run using the
command line.

4.1 XCC

To compile a program for your development board, enter the following commands:

1. xcc -print-targets

XCC displays a list of supported development boards.

2. xcc <file> -target=<board> -o <binary>

XCC compiles the file, generating an executable binary for your target board.

4.2 XRUN

To load a compiled program onto your development board, enter the following commands:

1. xrun -1

XRUN prints an enumerated list of all JTAG adapters connected to your PC and the devices on
each JTAG chain, in the form:

ID Name Adapter ID Devices

2. xrun --id <n> --io <binary>
XRUN loads your binary onto the hardware connected to the adapter with the specified ID.

The --io option causes XRUN to remain connected to the adapter, providing the standard
output stream from your hardware to the terminal.
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4.3 XGDB

To compile and debug your program, enter the following commands:

1. xcc <file> -target=<board> -o <binary> -g

XCC compiles your file with debugging information enabled.

2. xgdb bin.xe
GDB loads with a prompt.

3. list-devices

GDB prints an enumerated list of all JTAG adapters connected to your PC and the devices on
each JTAG chain, in the form:

ID Name Adapter ID Devices

4. connect --id <id>

GDB connects to your target hardware.

5. load
GDB loads your binary.

6. break main

GDB adds a breakpoint to the function main.

7. continue

GDB runs the program until it reaches main.

4.4 XSIM

To run your program on the simulator, enter the following command:

» xsim <binary>

To launch the simulator from within the debugger, at the GDB prompt enter the command:
» connect -s

You can then load your program onto the simulator in the same way as if using a development
board.
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5 XMOS Programming Guide

To help you access the real-time hardware features of XMOS multicore microcon-
trollers, XMOS has published a separate XMOS Programming Guide. This document
shows how to use the additional multicore language extensions for C (which collec-
tively form the xC language) to handle task based parallelism and communication,
accurate timing and I/0, and safe memory management.

The document contains many examples, including a simple Hello World application,
handling I/0 and button presses, a Tic-Tac-Toe game, an example of how to use
safe pointers for string processing, and a double buffering example.

To view and download the XMOS Programming Guide go to:

http://www.xmos.com/published/xmos-programming-guide
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6 Creating a new project in xTIMEcomposer

When you first open xTIMEcomposer, the Project Explorer and Exiting view are
empty. To get started you need to create a project to store your files in, which
xTIMEcomposer Studio can build and run on the target hardware or simulator.

1. Select File » New » xTIMEcomposer Project ({g).

2. Enter a Name for your project, and select a Workspace.

Project Name

Location
(#) Create new project in workspace

() Create new project in:

Users/huw/workspace

(®) Create a new application based project
Target Hardware
Select a Target

Copy XN file into new application

Application Software

| Name Version

Figure 6: @] Show content from https://www.xmos.com
Create xTIME-
composer
Project Create a new module based project
window

Description

3. Select your Target Hardware. This might be an xCORE device or a development
board. If you don’t have the hardware available you can develop your application

and run it on the simulator.
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Figure 7:
XTIMEcomposer
Project
Explorer and
empty XC file

o

4. xTIMEcomposer Studio includes an XN file for all the hardware targets, which
defines the system configuration and boot process. If you want to edit the XN
file select Copy XN file into new application. You can import the XN file after
you create the project if necessary.

5. Select Application Software » Empty XC File to create a project with an empty

source file.

6. Click Finish to create your project and source file.

L[ Project Explorer 23

& v =0
5

v =5 MyStartKitProject
» )Y Includes
> (= src
» (@ Installed Targets
P 2 STARTKIT.xn
=5 Makefile

- -
[xd MyStartKitProject.xc %\

-

* MyStartKitProject.xc

-

Created 2014

on: Oct 2,

Author:

The Makefile at the bottom of the project tree is used to configure the compiler
options for your project. Double-click the Makefile to open it in the Editor view.

You can now start editing the empty XC source file, or import a libraries/exam-

ple/application note.
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7 Sharing projects and code in xTIMEcomposer

IN THIS CHAPTER
Import a library
Import an example
Import an xTIMEcomposer project using a ZIP file

Export an xTIMEcomposer project as a ZIP file

xTIMEcomposer Studio has a set of views that you can use to import software into
your project from different sources including:

Libraries: browse the complete set of XMOS libraries and then drag them into
your project. The Libraries view appears on the Edit perspective.

&4 Libraries 2 S ElEHE = O

Content from https://www.xmos.com

Library
¥ Networking
JEthernet MAC library [lib_ethernet)
2 Time Sensitive Networking Library [lit

Figure 8: JEmbedded Webserver Library [lib_we
Libraries JTCP/IP Library [lib_xtcp)
browser ¥ Programming Utilities

2 GPIO Library [lib_gpio]

Examples: browse a library of application notes and examples that show how
to do the most common tasks in multicore applications. Many of the examples
have executable code that you can drag into your project.

&4 Examples 2 S El =8

Content from https://www.xmos.com

Software Example }
¥ Multi-feature case studies
JeCos on xCORE [AN00112)
JInterfacing High Speed ADCs with xCORE [AN01021]
V7 Networking examples

Figure 9: “XMOS 100Mbit Ethernet application note [AN00120]
Examples JUsing XMOS TCP/IP Library for UDP-based Networking [AN00121
browser JUsing the XMOS embedded webserver library [AN00122]

IXMOS Gigabit Ethernet application note [AN00199)]
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7.1 Import a library
To import a library follow these steps:

1. Select the Libraries view in the bottom left corner of the xXTIMEcomposer window
(Window » Show View » Libraries).

2. Double-click the library you want to import.
3. Select the version you require. The latest version is the default option.

4. Click Finish.

Documentation for the library is displayed in the Libraries Info window.

7.2 Import an example
To import a example follow these steps:
1. Select the Examples perspective.
2. Double-click the example you want to import.

3. Select the version you require. The latest version is the default option.

4. Click Finish.
Documentation for the example is displayed in the Examples info window.

7.3 Import an xTIMEcomposer project using a ZIP file
To import a project follow these steps:
1. Choose File » Import.

2. Double-click on the General option, select Existing Projects into Workspace
and click Next.

3. In the Import dialog box, click Browse (next to the Select archive file text
box).

4. Select the archive to import and click Open.

5. Click Finish.

7.4 Export an xTIMEcomposer project as a ZIP file
To export a project follow these steps:
1. Choose File » Export.

2. Double-click on the General option, select Archive File and click Next.
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3. Select the projects you wish to export in the top-left panel. You can exclude
files by deselecting them in the top-right panel.

4. Enter a name for the archive in the To archive file text box.

5. Click Finish.
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8 Use xTIMEcomposer Studio to build a project

To build your project, select your project in the Project Explorer, click the arrow
next to the Build buttonand select either Debug or Release.

XTIMEcomposer uses the Makefile in your project to determine the configuration
settings used with the compiler.

Double-click the project Makefile in the Project Explorer to open it in the Makefile
Editor, where you can set the compiler options. The XCC Command-Line Manual
(see §10) lists all supported compiler options.

fsd main.xc (?r XMOS Application Makefile Editor £3 =08
XMOS Application Makefile Editor

» Target

» App Name

» Used Modules
» Verbose

v Xcc Elags
The flags passed to xcc when building the application

<Default> I

-g-02 @
Tool Specific Flags [Overrides Above)

XC Compiler:
C Compiler:
CPP Compiler:
Mapper:
Figure 10:

Makefile Assembler:
Editor

If there are no errors in your program, xTIMEcomposer adds the compiled binary
file to the Binaries folder in your project.

Errors are reported in the Console. Double-click a message highlighted red to
locate it in the editor.
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9 XCC Pragma Directives

xTimeComposer supports the following pragmas.

#pragma

#pragma

#pragma

#pragma

#pragma

#pragma

unsafe arrays
(XC Only) This pragma disables generation of run-time safety checks that prevent
dereferencing out-of-bounds pointers and prevent indexing invalid array elements.
If the pragma appears inside a function it applies to the body of the next do, while
or for statement in that function. If the pragma appears outside a function the
scope it applies to the body of the next function definition.

loop unroll (n)
(XC only) This pragma controls the number of times the next do, while or for loop
in the current function is unrolled. n specifies the number of iterations to unroll,
and unrolling is performed only at optimization level 01 and higher. Omitting
the n parameter causes the compiler to try and fully unroll the loop. Outside of
a function the pragma is ignored. The compiler produces a warning if unable to
perform the unrolling.

stackfunction n
This pragma allocates n words (ints) of stack space for the next function declaration
in the current translation unit.

stackcalls n
(XC only) This pragma allocates n words (ints) of stack space for any function
called in the next statement. If the next statement does not contain a function call
then the pragma is ignored; the next statement may appear in another function.

ordered
(XC only) This pragma controls the compilation of the next select statement. This
select statement is compiled in a way such that if multiple events are ready when
the select starts, cases earlier in the select statement are selected in preference to
ones later on.

select handler

(XC only) This pragma indicates that the next function declaration is a select
handler. A select handler can be used in a select case, as shown in the example
below.

#pragma select handler
void f(chanend c¢, int &token, int &data);
select {

case f(c, token, data):

break;
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#pragma

#pragma

#pragma

#pragma

#pragma

#pragma

The effect is to enable an event on the resource that is the first argument to the
function. If the event is taken, the body of the select handler is executed before
the body of the case.

The first argument of the select handler must have transmissive type and the return
type must be void.

If the resource has associated state, such as a condition, then the select will not
alter any of that state before waiting for events.

fallthrough
(XC only) This pragma indicates that the following switch case is expected to
fallthrough to the next switch case without a break or return statement. This will
suppress any warnings/errors from the compiler due to the fallthrough.

xta label "name"
This pragma provides a label that can be used to specify timing constraints.

xta endpoint '"name"
(XC only) This pragma specifies an endpoint. It may appear before an input or
output statement.

xta call "name"
(XC only) This pragma defines a label for a (function) call point. Use to specify a
particular called instance of a function. For example, if a function contains a loop,
the iterations for this loop can be set to a different value depending on which call
point the function was called from.

xta command "command"
(XC only) This pragma allows XTA commands to be embedded into source code.
All commands are run every time the binary is loaded into the XTA. Commands are
executed in the order they occur in the file, but the order between commands in
different source files is not defined.

xta loop (integer)

(XC only) This pragma applies the given loop XTA iterations to the loop containing
the pragma.
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10XCC command-line options

IN THIS CHAPTER

Overall Options

Warning Options

Debugging Options

Optimization Options

Preprocessor Options

Linker And Mapper Options

Directory Options

Environment Variables Affecting XCC

Board Support Provided by <platform.h>

10.1

XCC is the front-end to the xXCORE C, C++ and XC compilers. Typical usage results
in preprocessing, compilation, assembly, linking, and mapping code and data onto
tiles. Some options allow this process to be stopped at intermediate stages and
other options are passed to one stage of processing. Most options have negative
forms (for example, -fno-option). A space between an option and its argument is
permitted.

Build settings for an application are defined in the application Makefile. Double
click the Makefile in the Project Explorer to open it in the Makefile Editor.

Overall Options

The four possible stages of compilation are preprocessing, compilation proper,
assembly and linking/mapping. The first three stages are applied to an individual
source file, producing an object file. Linking and mapping combine the object files
and an XN file into a single executable XE file, which contains the code and data
segments for each tile.
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Figure 11:
File
extensions
recognized
by XCC and
their
meaning

source-file

The suffix of a source file determines how it is handled by default.

Extension

Type of File Preprocessed by XCC

.XC
.C

.Cpp

.S

.Xta
.Xscope
.Xn

.xXi

i

Jii

.S
other

Assembly code
Object file .0 be given to the linker

XC source code Y
C source code Y

CPP source code (for compatability, the Y
extensions cc, cp, c++, C and cxx are also
recognized)

Assembly code

xCORE Timing Analyzer script
xSCOPE configuration file
xCORE Network Description
XC source code

C source code

C++ source code

zzzzzz 2z <

z

-xlanguage

-std=standard

Specifies the language for the following input files. This option ap-
plies to all following input files until the next -x option. Supported
values for language are:

pe
c

c++

assembler

assembler-with-cpp

xn

xta

xscope

none (turn off language specification)

Specifies the language variant for the following input C or C++ file.
Supported values for standard are:

c89
ISO C89
gnu89
ISO C89 with GNU extensions
c99
ISO C99
gnu99
ISO C99 with GNU extensions (default for C programs)
c++98
ISO C++ (1998)
gnu++98
ISO C++ (1998) with GNU extensions (default for C++ pro-
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-fsubword-select

In XC, allows selecting on channel inputs where the size of the
desstination variable is less than 32 bits.

This is default for targets based on XS1-L devices. It is not default
for targets based on XS1-G devices. For further details, see §47.3.

-target=platform

-foverlay

Specifies the target platform. The platform configuration must be
specified in the file platform.xn, which is searched for in the paths
specified by the XCC_DEVICE_PATH environment variable (see §10.8).

Enable support for memory overlays. Functions marked as overlay
roots are placed in external memory and are loaded on demand at
runtime. The option should be passed when compiling and linking.
An overlay runtime should be supplied in the application.

-foverlay=flash

Enable support for memory overlays linking in the flash overlay
runtime. Overlays are only enabled on tiles which boot from flash.

-foverlay=syscall

Enable support for memory overlays linking in the syscall overlay
runtime. Overlay are enabled on all tiles. Overlays are loaded from
a host machine using a system call.

-fxscope[=link|uart]

Enable support for tracing using xSCOPE (defaults to link). The XN
file of the target must contain an xSCOPE link. The option should
be passed when compiling and linking.

-funroll-loops

Unroll loops with small iteration counts. This is enabled at -0O2 and
above.

-finline-functions

Integrate simple functions into their callers. This is enabled at -02
and above and also at -Os.

-pass-exit-codes

Returns the numerically highest error code produced by any phase
of compilation. (By default XCC returns 1 if any phase of the
compiler returns non-success, otherwise it returns 0.)

Compiles or assembles the source files, producing an object file
for each source file, but does not link/map. By default the object
filename is formed by replacing the source file suffix with .o (for
example, a.c produces a.o).

XMO0980TA

XMOS



xTIMEcomposer User Guide for tools version 14.0.x 40/412

-S Stops after compilation proper, producing an assembly code file
for each nonassembly input file specified. By default the assembly
filename is formed by replacing the source file suffix with .s.

Input files not requiring compilation are ignored.
-E Preprocesses the source files only, outputting the preprocessed
source to stdout.

Input files not requiring preprocessing are ignored.

-ofile Places output in file.

If -0 is not specified, the executable file is placed in a.xe, the
object file for source.suffix in source.o, its assembly code file
in source.s, and all preprocessed C/C++/XC source on standard
output.

-v Prints (on standard error) the commands executed at each stage of
compilation. Also prints the version number of XCC, the preproces-
sor and the compiler proper.

—##t# The same as -v except that the commands are not executed and all
command arguments are quoted.

--help Prints a description of the supported command line options. If the
-v option is also specified, --help is also passed to the subprocesses
invoked by XCC.

--version Displays the version number and copyrights.

10.2 Warning Options

Many specific warnings can be controlled with options beginning -W. Each of the
following options has a negative form beginning -Wno- to turn off warnings.
-fsyntax-only

Checks the code for syntax errors only, then exits.

-w Turns off all warning messages.

-Wbidirectional-buffered-port
Warns about the use of buffered ports not qualified with either in
or out. This warning is enabled by default.

-Wchar-subscripts
Warns if an array subscript has type char.

-Wcomment Warns if a comment-start sequence /* appears in a /* comment, or
if a backslash-newline appears in a // comment. This is default.

-Wimplicit-int
Warns if a declaration does not specify a type. In C also warns about
function declarations with no return type.
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-Wmain Warns if the type of main is not a function with external linkage re-
turning int. In XC also warns if main does not take zero arguments.
In C also warns if main does not take either zero or two arguments
of appropriate type.

-Wmissing-braces
Warns if an aggregate or union initializer is not fully bracketed.

-Wparentheses
Warns if parentheses are omitted when there is an assignment in a
context where a truth value is expected or if operators are nested
whose precedence people often find confusing.

-Wreturn-type
Warns if a function is defined with a return type that defaults to int
or if a return statement returns no value in a function whose return
type is not void.

-Wswitch-default
Warns if a switch statement does not have a default case.

-Wswitch-fallthrough
(XC only) Warns if a case in a switch statement with at least one
statement can have control fall through to the following case.

-Wtiming Warns if timing constraints are not satisfied. This is default.

-Wtiming-syntax
Warns about invalid syntax in timing scripts. This is default.

-Wunused-function
Warns if a static function is declared but not defined or a non-inline
static function is unused.

-Wunused-parameter
Warns if a function parameter is unused except for its declaration.

-Wunused-variable
Warns if a local variable or non-constant static variable is unused
except for its declaration.

-Wunused Same as -Wunused-function, -Wunused-variable and
-Wno-unused-parameter.

-Wall Turns on all of the above -W options.

The following -W. .. options are not implied by -Wall.

-Wextra

-W Prints extra warning messages for the following:

A function can return either with or without a value (C, C++ only).
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-Wconversion

-Wdiv-by-zero
Warns about compile-time integer division by zero. This is default.

An expression statement or left-hand side of a comma expression
contains no side effects. This warning can be suppressed by
casting the unused expression to void (C, C++ only).

An unsigned value is compared against zero with < or <=.

Storage-class specifiers like static are not the first things in a
declaration (C, C++ only).

A comparison such as x<=y<=z appears (XC only).

The return type of a function has a redundant qualifier such as
const.

Warns about unused arguments if -Wall or -Wunused is also spec-
ified.
A comparison between signed and unsigned values could pro-

duce an incorrect result when the signed value is converted to
unsigned. (Not warned if -Wno-sign-compare is also specified.)

An aggregate has an initializer that does not initialize all mem-
bers.

An initialized field without side effects is overridden when using
designated initializers (C, C++ only).

A function parameter is declared without a type specifier in K&R-
style functions (C, C++ only).

An empty body occurs in an if or else statement (C, C++ only).

A pointer is compared against integer zero with <, <=, >, or >=.
(C, C++ only).

An enumerator and a non-enumerator both appear in a condi-
tional expression. (C++ only).

A non-static reference or non-static const enumerator and a non-
enumerator both appear in a conditional expression (C++ only).

Ambiguous virtual bases (C++ only).

Subscripting an array which has been declared register (C++
only).

Taking the address of a variable which has been declared
register (C++ only).

A base class is not initialized in a derived class’ copy constructor
(C++ only).

Warns if a negative integer constant expression is implicitly con-
verted to an unsigned type.
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-Wfloat-equal

Warns if floating point values are used in equality comparisons.

-Wlarger-than-len

-Wpadded

-Wreinterpret

-Wshadow

Warns if an object of larger than len bytes is defined.

Warns if a structure contains padding. (It may be possible to rear-
range the fields of the structure to reduce padding and thus make
the structure smaller.)

-alignment
Warns when a reinterpret cast moves to a larger alignment.

Warns if a local variable shadows another local variable, parameter
or global variable or if a built-in function is shadowed.

-Wsign-compare

Warns if a comparison between signed and unsigned values could
produce an incorrect result when the signed value is converted to
unsigned.

-Wsystem-headers

-Wundef

-Werror

Prints warning messages for constructs found in system header
files. This is not default. See §10.7.

Warns if an undefined macro is used in a #if directive.

Treat all warnings as errors.

-Werror=option

Turns a warning message into an error. The option should be one
of the warning options to the compiler that can be prefixed with -w.

By default, the flag -Werror=timing-syntax is set. Turning this
warning into an error implies that timing warnings (-Wtiming) are
also errors and vice versa.

10.3 Debugging Options

-8

-fxta-info

Produces debugging information.

Produces timing information for use with XTA. This is default.

-fresource-checks

-save-temps

Produces code in the executable that traps if a resource allocation
fails. This causes resource errors to be detected as early as possible.

Saves the intermediate files. These files are placed in the current
directory and named based on the source file.
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-fverbose-asm
Produces extra compilation information as comments in intermedi-
ate assembly files.

-dumpmachine
Prints the target machine and exit.

-dumpversion
Prints the compiler version and exit.

-print-multi-1lib
Prints the mapping from multilib directory names to compiler
switches that enable them. The directory name is seperated from
the switches by ‘;’, and each switch starts with a ‘@’ instead of the
‘-’, without spaces between multiple switches.

-print-targets
Prints the target platforms supported by the compiler. The target
names correspond to strings accepted by the -target option.

10.4 Optimization Options

Turning on optimization makes the compiler attempt to improve performance
and/or code size at the expense of compilation time and the ability to debug the

program.

-00 Do not optimize. This is the default.

-0

-01 Optimize. Attempts to reduce execution time and code size without
performing any optimizations that take a large amount of compila-
tion time.

-02 Optimize more. None of these optimizations involve a space-speed
tradeoff.

-03 Optimize even more. These optimizations may involve a space-
speed tradeoff; high performance is preferred to small code size.

-0s Optimize for the smallest code size possible.

-fschedule Attempt to reorder instructions to increase performance. This is
not default at any optimization level.

10.5 Preprocessor Options

The following options control the preprocessor.
-E Preprocesses only, then exit.

-Dname Predefines name as a macro with definition 1.
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-Dname=definition

-Uname

-MMD

-MF file

-MP

-MT file

Tokenizes and preprocesses the contents of definition as if it ap-
peared in a #define directive.

Removes any previous definition of name.

-D and -U options are processed in the order given on the command
line.

Outputs to a file a rule suitable for make describing the dependencies
of the source file. The default name of the dependency file is
determined based on whether the -o option is specified. If -0 is
specified, the filename is the basename of the argument to -o with
the suffix .d. If -0 is not specified, the filename is the basename
of the input file with the suffix .d. The name of the file may be
overriden with -MF.

The same as -MD expect that dependencies on system headers are
ignored.

Specifies the file to write dependency information to.

Emits phony targets for each dependency of the source file. Each
phony target depends on nothing. These dummy rules work around
errors make gives if header files are removed without updating the
Makefile to match.

Specifies the target of the rule emitted by dependency generation.

10.6 Linker And Mapper Options

The following options control the linker/mapper.

-llibrary Searches the library library when linking. The linker searches and
processes libraries and object files in the order specified. The actual
library name searched for is liblibrary .a.
The directories searched include any specified with -L.
Libraries are archive files whose members are object files. The
linker scans the archive for its members which define symbols that
have so far been referenced but not defined.

-nostartfiles
Do not link with the system startup files.

-nodefaultlibs
Do not link with the system libraries.

-nostdlib Do not link with the system startup files or system libraries.

-8

Removes all symbol table and relocation information from the exe-
cutable.
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-default-clkblk clk

-Wm,option

Use clk as the default clock block. The clock block may be specified
by its name in <xs1.h> or by its resource number.

The startup code turns on the default clock block, configures it to
be clocked off the reference clock with no divide and puts it into
a running state. Ports declared in XC are initially attached to the
default clock block. If this option is unspecified, the default clock
block is set to XS1_CLKBLK_REF.

Passes option as an option to the linker/mapper. If option contains
commas, it is split into multiple options at the commas.

To view the full set of advanced mapper options, type xmap --help.

-Xmapper option

-report

Passes option as an option to the linker/mapper. To pass an option
that takes an argument use -Xmapper twice.

Prints a summary of resource usage.

10.7 Directory Options

The following options specify directories to search for header files and libraries.

-Idir

-isystemdir

-iquotedir

-Ldir

Adds dir to the list of directories to be searched for header files.
Searches dir for header files after all directories specified by -I.
Marks it as a system directory.

The compiler suppresses warnings for header files in system direc-
tories.

Searches dir only for header files requested with #include "file"
(not with #include <file>) before all directories specified by -I
and before the system directories.

Adds dir to the list of directories to be searched for by -1.

10.8 Environment Variables Affecting XCC

The following environment variables affect the operation of XCC. Multiple paths
are separated by an OS-specific path separator (‘;’ for Windows, ‘:’ for Mac and

Linux).

XCC_INCLUDE_PATH

A list of directories to be searched as if specified with -1, but after
any paths given with -I options on the command line.

XCC_XC_INCLUDE_PATH
XCC_C_INCLUDE_PATH
XCC_CPLUS_INCLUDE_PATH
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XCC_ASSEMBLER_INCLUDE_PATH
Each of these environment variables applies only when preprocess-
ing files of the named language. The variables specify lists of
directories to be searched as if specified with -isystem, but after
any paths given with -isystem options on the command line.

XCC_LIBRARY_PATH
A list of directories to be searched as if specified with -L, but after
any paths given with -L on the command line.

XCC_DEVICE_PATH
A list of directories to be searched for device configuration files.

XCC_EXEC_PREFIX
If set, subprograms executed by the compiler are prefixed with the
value of this environment variable. No directory seperated is added
when the prefix is combined with the name of a subprogram. The
prefix is not applied when executing the assembler or the mapper.

XCC_DEFAULT_TARGET
The default target platform, to be located as if specified with
-target=. The default target platform is used if no target is specified
with -target= and no XN file is passed.

10.9 Board Support Provided by <platform.h>

During compilation of a program, the compiler generates a temporary header file
named platform.h that contains variable and macro definitions, as defined by the
target XN file, which includes:

Declarations of variables of type tileref (see §54.2).

Macro definitions of port names (see §54.4.2).
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11Using XMOS Makefiles

IN THIS CHAPTER

Applications and Modules

The Application Makefile
The module_build_info file

Projects created by xTIMEcomposer Studio have their build controlled by Makefiles.
These Makefiles execute the build using the program xmake which is a port of Gnu
Make?. The build is executable either from within xTIMEcomposer or from the
command line by calling xmake directly.

You do not need to understand the Gnu Makefile language to develop applications
using XTIMEcomposer. The common XMOS Makefile provides support for build-
ing applications and source code modules. You need only specify the required
properties of the build in Application Makefiles and Module build info files.

11.1 Applications and Modules

An application is made up of source code unique to the application and, optionally,
source code from modules of common code or binary libraries. When developing
an application, the working area is described in terms of workspaces, applications
and modules.

Workspace
A workspace is a container for several projects.

Applications
An application is a project containing source files and a Makefile that builds
into a single executable (.xe) file. By convention application directories start
with the prefix app_. These applications appear at the top level in the Project
Explorer in xTIMEcomposer.

Modules
A module is a directory containing source files and/or binary libraries. The
source does not build to anything by itself but can be used by applications. By
convention module directories start with the prefix module_. These modules
appear at the top level in the Project Explorer in xTIMEcomposer.

2http://www.gnu.org/software/make/
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11.1.1 Workspace structure and automatic module detection

Depending on the configuration of your workspace the Makefiles will search folders
on your file system to find modules used by an application.

The simplest structure is shown below:

app_avb_demol/
app_avb_demo2/
module_avbl/
module_avb2/
module_xtcp/
module_zeroconf/
module_ethernet/

In this case when building the applications, the build system will find the modules
on the same directory level as the applications.

Sometimes applications and modules are organized in separate repositories:

repol/
app_avb_demol/
module_avbl/

repo2/
module_zeroconf/

If the Makefiles detect that the folder containing the application is a repository then
the Makefiles will search the sub-folders of all repositories at the same nesting
level for modules (in this case the sub-folders of repol and repo2). The Makefiles
will detect a folder as a repository if one of the following conditions hold:

The folder has a .git sub-folder.
The folder starts with the prefix sc_, ap_, sw_, tool_ or 1ib_.
The folder contains a file called .xcommon_repo or xpd.xml.

If the folder above the application is detected as a repository but the folder above
that is then the Makefiles will search at that level. So in the following case:

repol/
examples/
app_avb_demol/
module_avbl/
repo2/
module_zeroconf/

The sub-folders of repol and repo2 will be searched.

In addition to the automatic searching for modules, the environment variable
XMOS_MODULE_PATH can be set to a list of paths that the Makefiles should search.
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If you just want to solely use the user specified search path then the auto-
matic searching for modules can be disabled by setting the environment variable
XCOMMON_DISABLE_AUTO_MODULE_SEARCH to 1.

11.2 The Application Makefile

Every application directory should contain a file named Makefile that includes
the common XMOS Makefile. The common Makefile controls the build, by default
including all source files within the application directory and its sub-directories.
The application Makefile supports the following variable assignments.
XCC_FLAGS[_config]

Specifies the flags passed to xcc during the build. This option sets
the flags for the particular build configuration config. If no suffix is
given, it sets the flags for the default build configuration.

XCC_C_FLAGS[_config]
If set, these flags are passed to xcc instead of XCC_FLAGS for all .c
files. This option sets the flags for the particular build configuration
config. If no suffix is given, it sets the flags for the default build
configuration.

XCC_ASM_FLAGS[_config]
If set, these flags are passed to xcc instead of XCC_FLAGS for all
.s or .S files. This option sets the flags for the particular build
configuration config. If no suffix is given, it sets the flags for the
default build configuration.

XCC_MAP_FLAGS[_config]
If set, these flags are passed to xcc for the final link stage instead
of XCC_FLAGS. This option sets the flags for the particular build
configuration config. If no suffix is given, it sets the flags for the
default build configuration.

XCC_FLAGS_filename
Overrides the flags passed to xcc for the filename specified. This
option overrides the flags for all build configurations.

VERBOSE If set to 1, enables verbose output from the make system.

SOURCE_DIRS Specifies the list of directories, relative to the application directory,
that have their contents compiled. By default all directories are
included.

INCLUDE_DIRS
Specifies the directories to look for include files during the build.
By default all directories are included.

LIB_DIRS Specifies the directories to look for libraries to link into the ap-
plication during the build. By default all directories are included.
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EXCLUDE_FILES
Specifies a space-separated list of source file names (not including
their path) that are not compiled into the application.

USED_MODULES
Specifies a space-separated list of module directories that are com-
piled into the application. The module directories should always be
given without their full path irrespective of which project they come
from, for example USED_MODULES = module_xtcp module_ethernet.

MODULE_LIBRARIES
This option specifies a list of preferred libraries to use from modules
that specify more than one. See §12 for details.

11.2.1 Combined xCORE/ARM applications

XCORE_ARM_PROJECT
This option should be set to 1 for applications that wish to build
for dual architecture chips such as the XA-series. In this case the
build will compile the source files of the project into two binaries -
one for xCORE and one for ARM.

XCORE_ONLY_DIRS
This option specifies the directories within the project that should
only be used as part of the xCORE build. If not set it will default to
src/xcore

ARM_ONLY_DIRS
This option specifies the directories within the project that should
only be used as part of the ARM build. If not set it will default to
src/arm.

ARM_GCC_FLAGS[_config]
Specifies the flags passed to gcc during the build. This option sets
the flags for the particular build configuration config. If no suffix is
given, it sets the flags for the default build configuration.

ARM_GCC_C_FLAGS[_config]
If set, these flags are passed to gcc instead of ARM_GCC_FLAGS for all
.c files. This option sets the flags for the particular build configu-
ration config. If no suffix is given, it sets the flags for the default
build configuration.

ARM_GCC_ASM_FLAGS[_config]
If set, these flags are passed to gcc instead of ARM_GCC_FLAGS for
all .s or .S files. This option sets the flags for the particular build
configuration config. If no suffix is given, it sets the flags for the
default build configuration.
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ARM_GCC_LD_FLAGS[_config]
If set, these flags are passed to gcc for the final link stage instead
of ARM_GCC_FLAGS. This option sets the flags for the particular build
configuration config. If no suffix is given, it sets the flags for the
default build configuration.

ARM_GCC_FLAGS_filename
Overrides the flags passed to arm_gcc for the filename specified.
This option overrides the flags for all build configurations.

EMBED_XCORE_IMAGE_IN_ARM_IMAGE
If this variable is set to 1 then the xCORE image will be embedded
into the ARM image so that ARM can boot the xCORE.
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11.3 The module_build_info file

Each module directory should contain a file named module_build_info. This file
informs an application how to build the files within the module if the application
includes the module in its build. It can optionally contain several of the following
variable assignments.
DEPENDENT _MODULES
Specifies the dependencies of the module. When an application
includes a module it will also include all its dependencies.

MODULE_XCC_FLAGS
Specifies the options to pass to xcc when compiling source files
from within the current module. The definition can reference
the XCC_FLAGS variable from the application Makefile, for example
MODULE_XCC_FLAGS = $(XCC_FLAGS) -03.

MODULE_XCC_XC_FLAGS
If set, these flags are passed to xcc instead of MODULE_XCC_FLAGS
for all .xc files within the module.

MODULE_XCC_C_FLAGS
If set, these flags are passed to xcc instead of MODULE_XCC_FLAGS
for all . c files within the module.

MODULE_XCC_ASM_FLAGS
If set, these flags are passed to xcc instead of MODULE_XCC_FLAGS
for all .s or .s files within the module.

OPTIONAL_HEADERS
Specifies a particular header file to be an optional configuration
header. This header file does not exist in the module but is provided
by the application using the module. The build system will pass the
a special macro __filename_h_exists__ to xcc if the application
has provided this file. This allows the module to provide default
configuration values if the file is not provided.

11.3.1 Modules for combined xCORE/ARM applications
XCORE_ARM_PROJECT
This option should be set to 1 for modules that wish to build for dual
architecture chips such as the XA-series. This will allow modules to
participate in applications with this flag set and compile into the
ARM part of the build.

XCORE_ONLY_DIRS
This option specifies the directories within the module that should
only be used as part of the xCORE build. If not set it will default to
src/xcore
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ARM_ONLY_DIRS
This option specifies the directories within the module that should
only be used as part of the ARM build. If not set it will default to
src/arm.

MODULE_ARM_GCC_FLAGS
Specifies the options to pass to gcc when compiling source files
from within the current module. The definition can reference the
ARM_GCC_FLAGS variable from the application Makefile, for example
MODULE_ARM_GCC_FLAGS = $(ARM_GCC_FLAGS) -03.

MODULE_ARM_GCC_XC_FLAGS
If set, these flags are passed to gcc instead of
MODULE_ARM_GCC_FLAGS for all .xc files within the module.

MODULE_ARM_GCC_C_FLAGS
If set, these flags are passed to gcc instead of
MODULE_ARM_GCC_FLAGS for all .c files within the module.

MODULE_ARM_GCC_ASM_FLAGS
If set, these flags are passed to gcc instead of
MODULE_ARM_GCC_FLAGS for all .s or .s files within the module.
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12Using XMOS Makefiles to create binary libraries

IN THIS CHAPTER
The module_build_info file

The module Makefile

Using the module

The default module system used by XMOS application makefiles includes common
modules at the source code level. However, it is possible to build a module into a
binary library for distribution without the source.

A module that is to be built into a library needs to be split into source that is used
to build the library and source/includes that are to be distributed with the library.
For example, you could specify the following structure.

module_my_library/
Makefile
module_build_info
libsrc/
my_library.xc
src/
support_fns.xc
include/
my_library.h

The intention with this structure is that the source file my_library.xc is compiled
into a library and that library will be distributed along with the src and include
directories (but not the 1ibsrc directory).

12.1 The module_build_info file
To build a binary library some extra variables need to be set in the
module_build_info file. One of the LIBRARY or LIBRARIES variables must be set.
LIBRARY This variable specifies the name of the library to be created, for
example:
LIBRARY = my_library
LIBRARIES This variable can be set instead of the LIBRARY variable to specify
that several libraries should be built (with different build flags), for
example:
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LIBRARY = my_library my_library_debug

The first library in this list is the default library that will be linked
in when an application includes this module. The application
can specify one of the other libraries by adding its name to its
MODULE_LIBRARIES list.

LIB_XCC_FLAGS_libname
This variable can be set to the flags passed to xcc when compiling
the library libname. This option can be used to pass different
compilation flags to different variants of the library.

EXPORT_SOURCE_DIRS
This variable should contain a space separated list of directories
that are not to be compiled into the library and distributed as source
instead, for example:

EXPORT_SOURCE_DIRS = src include

12.2 The module Makefile

Modules that build to a library can have a Makefile (unlike normal, source-only
modules). The contents of this Makefile just needs to be:

XMOS_MAKE_PATH 7= ../..
include $(XMOS_MAKE_PATH)/xcommon/module_xcommon/build/Makefile.library

This Makefile has two targets. Running make all will build the libraries. Calling the
target make export will create a copy of the module in a directory called export
which does not contain the library source. For the above example, the exported
module would look like the following.

export/
module_my_library/
module_build_info
1ib/
xs1lb/
libmy_library.a
src/
support_£fns.xc
include/
my_library.h

12.3 Using the module
An application can use a library module in the same way as a source module

(including the module name in the USED_MODULES list). Either the module with the
library source or the exported module can be used with the same end result.
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13Use xTIMEcomposer to time a program

IN THIS CHAPTER

Launch the timing analyzer

Time a section of code

Specify timing requirements

Add program execution information

Validate timing requirements during compilation

The xCORE Timing Analyzer lets you determine the time taken to execute code on
your target platform. Due to the deterministic nature of the xCORE architecture, the
tools can measure the shortest and longest time required to execute a section of
code. When combined with user-specified requirements, the tools can determine at
compile-time whether all timing-critical sections of code are guaranteed to execute
within their deadlines.

13.1 Launch the timing analyzer

To load a program under control of the timing analyzer, follow these steps:

1.
2.

5.
6.

Select a project in the Project Explorer.

Choose Run » Time Configurations.

. In the left panel, double-click XCore Application. xTIMEcomposer creates a

new configuration and displays the default settings in the right panel.

. XTIMEcomposer tries to identify the target project and executable for you. To

select one yourself, click Browse to the right of the Project text box and select
your project in the Project Selection dialog box. Then click Search Project and
select the executable file in the Program Selection dialog box.

You must have previously compiled your program without any errors for the
executable to be available for selection.

In the Name text box, enter a name for the configuration.

To save the configuration and launch the timing analyzer, click Time.

xTIMEcomposer loads your program in the timing analyzer and opens it in the
Timing perspective. In this perspective the editor is read-only, to ensure the
relationship between the binary and source code remains consistent.
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XTIMEcomposer remembers the configuration last used to load your program. To
load XTA the program later using the same settings, just click the XTA button. To
use a different configuration, click the arrow to the right of the XTA button and
select a configuration from the drop-down list.

13.2 Time a section of code

ull

A route consists of the set of all paths through which control can flow between
two points (or endpoints) in a program. Each route has a best-case time, in which
branches always follow the path that takes the shortest time to execute, and a
corresponding worst-case time.

To specify a route and analyze it, follow these steps:

1. Right-click on an endpoint marker in the editor margin and choose Set from
endpoint. xTIMEcomposer displays a green dot in the top-right quarter of the
marker.

2. Right-click on an endpoint marker and choose Set to endpoint. xTIMEcomposer
displays a red dot in the bottom-right quarter of the marker.

You can specify a start point above an end point. You can also specify a start
point at or below an end point, defining a route whose paths flow out and then
back into the function. This is typical of functions called multiple times or from
within a loop.

3. Click the Analyze Endpoints button in the main toolbar. xTIMEcomposer
analyzes all the paths in the specified route, displaying a tree-like representation
in the lower panel of the Routes view and a graph-like representation in the
Structure tab of the Visualizations view.

Alternatively, to analyze the time taken to execute a function, just click the
Analyze Function button in the main toolbar and select a function from the
drop-down list.
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XTIMEcomposer provides endpoint markers for all statements whose order is
guaranteed to be preserved during compilation. These statements include 1/0
operations and function calls.

13.2.1 Visualize a route

The Routes view displays a structural representation of the route. Each time you
analyze a route, an entry is added to the top panel. Click on a route to view it in
the bottom panel. It is represented using the following nodes:

3¢ A source-level function.
¥ Alist of nodes that are executed in sequence.
@ A set of nodes that are executed conditionally.
(5 A loop consisting of a sequence of nodes in which the last node can branch back
to the first node.
:= A block containing a straight-line sequence of instructions.
— A single machine instruction.
13.2.2 The Visualizations view
The Visualizations view provides graphical representations of the route. The
Structure tab represents the route as a line that flows from left to right, as shown
in the example below. The route forks into multiple paths whenever the code
branches, and all paths join at its end. The best-case timing path is highlighted in
green, the worst-case path in red, and all other paths are colored gray.
Function name
4
o o
o Best path
0
y Loop
checkiWord
Hemmmmy | o i || f#0— End
J 6,0 ‘[D[
s Worst path
B\ Unknown
gl 0
0 Path
Figure 13: G " )
Visualizations pul /e Instruction block
view Start
In both the Route view and Structure view, you can hover over a node to display a
summary of its timing properties. Click on a node to highlight its source code in
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the editor, or double-click to go to the line at the start of the node. In the Structure
view, double-click on a function name to expand or collapse it.

13.3 Specify timing requirements

x S <

13.4 Add

A timing requirement specifies how long the paths in a route may take to execute
for the program to behave correctly. In the top panel of the Routes view, the status
of each route is indicated by an icon to the left of its name:

No timing requirement is specified.

A timing requirement is specified and met.

A timing requirement is specified and met, subject to all I/0 instructions being
ready to execute.

A timing requirement is specified and not met.

To specify a timing requirement, right-click on a route and choose Set timing
requirements. A dialog box opens. Enter the maximum time in which the paths
must execute in either ns, cycles or MHz and click OK. xTIMEcomposer updates
the status of the route.

program execution information

Under some conditions the timing analyzer is unable to prove timing without
additional information. Examples of common conditions include:

The route contains an I/0O instruction that can pause for an unknown length of
time.

The route contains a loop with a data-dependent exit condition.

A path fails to meet timing, but the path is only executed as a result of an error
condition and is not therefore timing critical.

In these cases you can provide the timing analyzer additional information about the
execution of your program. Armed with this additional information, the analyzer
may then be able to prove that a route’s timing requirement is met. Information
you can provide includes:

» The number of loop iterations: Right-click on a loop node and choose Set loop
iterations to display a dialog box. Enter a maximum loop count and click OK.

» The maximum pause time for an 1/0 instruction: Right-click on an instruction
node and choose Set instruction time to display a dialog box. Enter a value,
select a unit of time/rate (such as nanoseconds or MHz) and click OK.

» Exclude a path from the route: Right-click on a node and choose Exclude.
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13.4.1 Refine the worst-case analysis

By default, the timing analyzer assumes that a route always follows branches that
take the longest time to execute. If you know that this is not the case, for example
through inspection during simulation or a formal analysis of your program, you can
refine the parameters used by the analyzer. Refinements you can make include:

» Specifying an absolute execution time for a function call: Right-click on a
function node and choose Set function time to open a dialog box. Enter a time
and click OK.

» Specifying an absolute time for a path: Select a path by holding down Ctrl
(Windows, Linux) or 8 (Mac) and clicking on two instruction nodes, then right-
click and choose Set path time to open a dialog box. Enter a time and click
OK.

» Specifying the number of times a node is executed: By default, the analyzer
assumes that the number of times a node is executed is the multiplication of
each loop count in its scope. To change the iteration count to be an absolute
value, right-click on a node and choose Set loop scope to open a dialog box.
Select Make scope absolute and click OK.

» Specifying the number of times a conditional is executed in a loop: By de-
fault, the analyzer assumes that a conditional node always follows the path that
takes the longest time to execute. To specify the number of times a conditional
target is executed, right-click on the target node and choose Set loop path
iterations to open a dialog box. Enter the number of iterations and click OK.

13.5 Validate timing requirements during compilation

Once you’ve specified the timing requirements for your program, including any
refinements about its execution, you can generate a script that checks these
requirements at compile-time.

To create a script that checks all timing requirements specified in the Routes view,
follow these steps:

1. Click the Generate Script button.

2. In the Script location text box, enter a filename for the script. The filename
must have a .xta extension.

3. To change the names of the pragmas added to the source file, modify their
values in the Pragma name fields.

4. Click OK to save the script and update your source code. xTIMEcomposer adds
the script to your project and opens it in the editor. It also updates your source
files with any pragmas required by the script.

The next time you compile your program, the timing requirements are checked
and any failures are reported as compilation errors. Double-click on a timing error
to view the failing requirement in the script.
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Figure 14:
Script
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14 Use the XTA from the command line

IN THIS CHAPTER

Frequently used commands

Viewing results

Refining timing results

Program structure

Automating the process

Scripting XTA via the Jython interface

The XTA tool can be used interactively on the command-line or the console in
XTIMEcomposer Studio.

14.1 Frequently used commands

This section summarizes a number of frequently used commands that can be run
from the command line.

14.1.1 Loading a binary
To load a binary type:

load <FILE NAME>

14.1.2 Routes
A route is a timing-critical section of code. It consists of the set of all paths through

which control can flow between two points in a program (endpoints). A route can
be created by timing a function, timing a loop or by timing between endpoints.

14.1.3 Endpoints

An endpoint is any source line that, during the compilation process, must be
preserved, and its order with respect to other endpoints must be maintained.

To show a list of all endpoints type:

list allendpoints

If specifying a route with respect to assembly code then any valid label/program
counter (PC) can be used as an endpoint. However, program counters are classed
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as non-portable endpoints as they are likely to change between compilations and
their use in scripts is therefore discouraged.

14.1.4 Adding endpoints to source

Source lines can be labeled with endpoint pragmas to ensure that the endpoints
are portable. For example, Figure 15 shows a function that has been annotated
with endpoint pragmas called start and stop.

int g(in port p) {
int x, y;

# pragma xta endpoint " start "
p > x;
Figure 15: # pragma xta endpoint " stop "
Putting an P >y
endpoint
pragma into return (y - x);

the souce }

To show a list of endpoints type:

list endpoints

14.1.5 Timing between endpoints
To time between endpoints type:

analyze endpoints <from ENDPOINT> <to ENDPOINT>

The XTA does not time code across multiple xCORE tiles so both endpoints must
be on the same tile.

BB

One analysis can result in multiple routes being generated.

14.1.6 Timing functions

Type the function name on the console:

analyze function <FUNCTION>

This will create a route which describes the set of all possible paths from the
function entry point to all the function return points.
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14.1.7 Timing loops
To time a loop type:

analyze loop <ANY>

This creates a route that describes all possible paths through the loop. It it
effectively a shortcut for timing between endpoints where the start and stop
endpoint is the same, the point is within a loop and an exclusion has been placed
such that everything outside the loop is excluded.

One analysis can result in multiple routes being generated.
14.1.8 Setting timing requirements
To define the timing requirements for a route type:
set required <route id> <value> <MODE>
The supported timing modes are defined in §15.3.
The route IDs can be found by typing:

print summary

Alternatively, the - character can be used on the command-line or in a script to
refer to the last route analyzed.

14.2 Viewing results

14.2.1 Route IDs

All analyzed routes are given a unique route ID. However, when referring to routes
in a script, using the route ID may not always result in portable or robust scripts.
In many cases, the only route that needs to be referenced is the one that was last
analyzed. This can be achieved by using the ‘-’ character as the route ID. If the last
command created multiple routes then the ‘-’ character refers to all of the routes
created.

14.2.2 Node IDs
Within a single route, all nodes are assigned a unique ID number. This is required

as input for some of the console commands. The ‘-’ character can be used in this
context to refer to the top level node of the route.

14.2.3 Summary

To show a list of all routes type:
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print summary

Details for a specific route are shown using the command:

print routeinfo <route id>

14.2.3.1 Violation

When a timing requirement has been set for a route and the route takes more
time to execute than required, the time difference is called a violation. This value
specifies how much faster the route needs to be executed in order to meet the
timing requirement.

14.2.3.2 Slack

When a timing requirement has been set for a route and the route takes less time to
execute than required, the time difference is called slack. This value specifies how
much slower the route could be executed and still meet the timing requirement.

14.2.4 Structure
To display the the structure of a route in xTIMEcomposer Studio type:

print structure <route id>
The structure used by the XTA is described in §14.4.2.

14.2.5 Source code annotation
To display the source code which is executed by a route type:

print src <route id>

If only a part of a route should be used then the node ID can be specified:

print src <route id> <node id>

14.2.6 Instruction traces

To help developers understand the execution flow of a route, the XTA can create
representative instruction traces. Type:

print trace <route id>
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As a result of loops being unrolled when tracing, it is possible for the traces to get
very large. The trace operation can be cancelled at any time by pressing CTRL+C in
the command-line tool.

A trace can be redirected to a file by typing:

print trace <route id> > <file>

By default, the trace for worst-case path is printed. This can be changed to print
the best-case path instead by typing:

config case best

14.2.7 Fetch no-ops

The xCORE device may need to pause at certain times while more instructions are
fetched from memory. This results in the issue of fetch no-op instructions. These
are shown in the traces as FNOP at the points they will happen on the hardware.

In XTIMEcomposer Studio they are inserted into the disassembly at the points they
occur.

14.2.8 Scaling Results

By default, the XTA scales all timing results. This means that the appropriate unit
(ms, us, ns) will be used to print time values. This can be changed so that all times
are printed in ns by typing:

config scale false

14.2.9 Unknowns

The XTA may not always be able to determine the exact timing of a section of
code if it is unable to determine loop iteration counts or the execution time of
instructions. These unknown conditions can be displayed on the console by typing:

list unknowns <route id>

§14.3 describes how to address these warnings.

14.3 Refining timing results

There are cases where the XTA is unable to fully determine the timing of a section
of code, due to, for example, not being able to determine a loop count. This can
be addressed by adding defines. Defines can be added in two ways, to a global list,
or to a route-specific list. Those added to the global list get applied to every route
when upon creation.
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A

Figure 16:
Excluding an
invalid path

The use of the global list can result in more concise scripts. However, It is important
to be careful with defines added to the global list since they are ignored if they fail
to get applied to a route. This allows a full set of defines to be created before any
routes, but does mean that errors in these defines might be missed. Route specific
defines (added post route creation) will always flag an error if there is one.

14.3.1 Exclusions

Not all paths of execution in a route may be timing-critical. The route may contain
cases to handle errors where the timing of the code is not important. These paths
can be ignored in the timing script by adding exclusions. Exclusions tell the XTA to
ignore all paths which pass through that code point. Exclusions can be added to
the global list or applied to a specific route.

To set an exclusion on an existing route type:

set exclusion <route id> <ANY>

To add an exclusion to the list of exclusions to be taken into account during route
creation type:

add exclusion <ANY>

To list the global list of exclusions type:

list exclusions

To remove an exclusion from the global list type:

remove exclusion <ANY|x*>

For example, consider the code in Figure 16.

int calculate ( int a, int b) {
if ( willOverflow (a, b) {
# pragma xta label " overflow "
return processOverflow ();
}

return a + b;

To time the calculate function ignoring the error case:

Using route-specific defines:
analyze function calculate

set exclusion - overflow
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> B

Using global defines:

add exclusion overflow

analyze function calculate
Although functionally equivalent, exclusion via the global defines mechanism can
result in faster, and more memory efficient, route creation. This is because the
global exclusions can be taken into account during route creation, so the search
space can be reduced. For post route creation exclusions, the complete route is
created before any pruning occurs.
14.3.2 Loop lterations

Loop iteration counts can be unknown. Whenever possible, the compiler tells
the XTA about loop iteration counts. However, some loop counts are not known
statically. In these cases developers must specify worst-case values.

The compiler does not emit any loop iteration counts unless optimizations have
been enabled (-O1 or greater).

Some loops are self loops (loops whose body is the same as the header) and
therefore have a minimum iteration count of 1.

To set loop iterations on an existing route type:

set loop <route id> <ANY> <iterations>

To add an iteration count to the list of iteration counts to be used during route
creation type:

add loop <ANY> <iterations>

To list the current global loop iteration counts type:

list loops

To remove a loop iteration count from the global list type:

remove loop <ANY|x>

For example, consider the code in Figure 17.
To time the test function:

Using route-specific defines:
analyze function test

set loop - delay_loop 10

Using global defines:
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Figure 17:
Setting loop

iterations.

void delay ( int j) {
for ( unsigned int i = 0; i < j; ++i) {
# pragma xta label " delay_loop "
delay_us (1);
}
int test () {

delay (10);
}

add loop delay_loop 10

analyze function test
14.3.3 Loop path iterations
A loop may contain multiple paths through it. When a loop iteration count has been
set the tools assumes that all iterations will take the worst-case path of execution
through the loop. This is not always the case, and a more realistic worst-case can

be established by specifying the number of iterations on individual paths through
the loop.

To set loop path iterations on an existing route type:

set looppath <route id> <ANY> <iterations>

To add a loop path count to the list of loop path counts to be used during route
creation type:

add looppath <ANY> <iterations>
To display the current list of global loop path counts type:

list looppaths

To remove a loop path count from the global list type:

remove looppath <ANY|x*>

There are some rules that need to be followed when setting loop path iterations:
In a nested loop, the outer loop iterations need to be set first.

The loop path iterations set must be less than or equal to the loop iterations set
on the enclosing loop.
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If the loop path iterations set are less than that of the enclosing loop, then there
must exist another path within the loop without its iterations set to which the
remaining iterations can be allocated.

For example, consider the code in Figure 18:

void £( int j) {

for ( unsigned int i = 0; i < j; ++i) {
# pragma xta label " f_loop "
if ((1i & 1) == 0) {
# pragma xta label " f_if "
g O3
}
}
}
Figure 18:
Setting loop int test () {
path f (10);

iterations. |}

To time the test function:

Using route-specific defines:
analyze function test
set loop - f_loop 10
set looppath - f_if 5

Using global defines:
add loop f_loop 10
add looppath f_if 5

analyze function test

14.3.4 Loop scope

By default, the XTA assumes that the iterations for loops are relative—the iterations
for an inner loop will be multiplied by the iterations of enclosing loops. However
this is not sufficient to describe all loop structures. If this assumption is not correct
a loop count can be set to absolute. The iteration count set on an absolute loop is
not multiplied up by the iterations set on enclosing loops.

To set loop scope on an existing route type:

set loopscope <route id> <ANY> <absolute|relative>

To add a loop scope to the list of loop scopes to be used during route creation
type:
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add loopscope <ANY> <absolutel|relative>

To display the current list of global loop scopes, type:

list loopscopes

To remove a loop scope from the global list, type:

remove loopscope <ANY|x*>

For example, consider the code in Figure 19

void £( int 1) {

for ( unsigned int i = 0; i < 1; ++i) {
# pragma xta label " outer_loop "
for ( unsigned int j = 0; j < i; ++j) {
# pragma xta label " inner_loop "
g O3
}
}
}
Figure 19:  void test () {
Setting loop £ (10);
scope. 1}

To time the test function:

Using route-specific defines:
analyze function test
set loop - outer_loop 10
set loop - inner_loop 45

set loopscope - inner_loop absolute

Using global defines:
add loop outer_loop 10
add loop inner_loop 45
add loopscope inner_loop absolute

analyze function test
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14.3.5 Instruction times

Some instructions can pause the processor. By default, the XTA reports timing
assuming that no instructions pause, but flags them as warnings. Developers must
specify what the worst-case execution time of instructions are.

To set an instruction time in an existing route, type:

set instructiontime <route id> <ENDPOINT> <value> <MODE>

To add an instruction time to the list of instruction times to be used during route
creation, type:

add instructiontime <ENDPOINT> <value> <MODE>
To display the current list of global instruction times, type:
list instructiontimes

To remove an instruction time from the global list, type:

remove instructiontime <ANY|*>

For example, consider the code in Figure 20.

Figure 20:  void f( port p) {

Setting an # pragma endpoint " instr "
instruction p :> value ;
time. 2}

To time the f function:

Using route-specific defines:
analyze function f

set instructiontime - instr 100.0 ns

Using global defines:
add instructiontime instr 100.0 ns

analyze function f

14.3.6 Function times

In some cases it is necessary to define the time it takes to execute an entire
function. The XTA supports defining a function time. Once a function time is
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defined, all the unknowns within it are ignored and any routes which span this
function will use the defined time instead of calculating it.

To set a function time on an existing route, type:

set functiontime <route id> <FUNCTION> <value> <MODE>

To add a function time to the list of function times to be used during route creation,
type:

add functiontime <FUNCTION> <value> <MODE>

To display the current list of global function times, type:

list functiontimes

To remove an function time from the global list, type:

remove functiontime <FUNCTION |x*x>
For example, consider the code in Figure 21.

void delayOneSecond () {
g O;
}

Figure 21: void test () {
Setting a delayOneSecond ();
function time.  }

To time the test function:

Using route-specific defines:
analyze function test

set functiontime - delayOneSecond 1000.0 ms

Using global defines:
add functiontime delayOneSecond 1000.0 ms

analyze function test

14.3.7 Path times

In some cases it is necessary to define the time it takes to execute a particular
section of code. The XTA supports defining a path time for this case. Once a path
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time is defined all the unknowns within it are ignored, and any routes which span
this section of code will use the defined time instead of calculating it.

To set a path time on an existing route, type:

set pathtime <route id> <from ENDPOINT> <to ENDPOINT> <value> <MODE>

To add a path time to the list of path times to be used during route creation, type:

add pathtime <from ENDPOINT> <to ENDPOINT> <value> <MODE>

To display the current list of global path times, type:

list pathtimes

To remove an path time from the global list, type:

remove pathtime <from ENDPOINT |*> <to ENDPOINT |*>

For example, consider the code in Figure 22.

int £() {
int time ;
timer t;
# pragma xta endpoint " start "
t :> time ;
# pragma xta endpoint " stop "
t when timerafter ( time + 100) :> time ;
}
Figure 22:  void test () {
Setting a path £f O3
time. |}

To time the test function:
Using route-specific defines:
analyze function test

set pathtime - start stop 1000.0 ns

Using global defines:
add pathtime start stop 1000.0 ns

analyze function test
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14.3.8 Active tiles

By default the XTA finds routes on all tiles within a program. However, it is possible
to restrict the XTA to work only on a subset of the tiles in the program. The set of
tiles all commands apply to is called the active tiles.

To select which tiles are active, type:
add tile <tile id>
remove tile <tile id|*>

list tiles

14.3.9 Node frequency

An XCORE device consists of a number of nodes, each one composed of a number
of xCORE tiles. The frequency at which a node runs is defined in the binary and
the XTA reads this and configures the node frequencies when it loads the binary. It
is possible to experiment to determine what will happen at different frequencies if
desired.

To change the frequency for the node, type:

config freq <node id> <tile frequency>

14.3.10 Number Of logical cores
The maximum number of logical cores run on a tile is known at compile time and
the XTA extracts this information from the binary for each tile. It is possible to

experiment to determine what will happen if running with a different number of
cores if desired.

To change the number of cores for the node/tile, type:

config cores <tile id> <num cores>

14.4 Program structure

Programs are written in multiple source files, each containing functions. Each
function will contain sequences of statements, loops (e.g. for / while / do),
conditionals (e.g. if / switch) and function calls.

14.4.1 Compiling for the XTA

The compiler outputs information which allows the XTA to make associations
between source and instructions. This information is on by default but can be
disabled by adding the following flag to the compiler options:
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-fno-xta-info

The compiler also supports adding debug information without affecting optimiza-
tions. Debug information is not required for the XTA to analyze code, but the
mapping between instructions and source code is not available without the debug
information. In order to add debug information compile with:

-g

14.4.2 Structural nodes

The compiler tools create a binary file with one program per xCORE tile. The XTA
uses the binary file to produce accurate timing results.

When a route is created, the XTA analyzes the binary to create a structure which
closely represents the high-level program structure. It decomposes the program
into structural nodes which can be displayed as a tree.

The worst and best case time is then calculated for each of the structural nodes.
The way this is calculated depends on the type of structural node. The worst and
best case times for the overall route is built up from the worst and best case times
of the sub nodes.

The structural nodes can be of the following types:
Instruction: the most basic building block of the program is the instruction.

Block: a list of instruction nodes with no conditional branching which is therefore
executed in sequence. The worst/best case time for a block is the sum of its
component instructions.

Sequence: a list of structural nodes which are executed in order. The worst/best
case time for a sequence is the sum of the worst/best case times of its sub
nodes.

Conditional: a set of structural nodes out of which at most one node is executed.
If this is within a loop then on each iteration a different node might be chosen.
In some cases the entire conditional is optional. In those cases the best case
time is for none of the options to be taken. The worst/best case time for a
conditional is determined by the worst/best case time of each of its sub nodes.

Loop: consists of a header and a body (both of which are structural nodes).
The header corresponds to the conditional test part of the loop, and the body
corresponds to the code that is executed if the loop is taken. This roughly
corresponds to high level code structures such as while or for loops.

The body is executed once per iteration. The header always executes once
more than the number of iterations. The worst/best case times for a loop is the
worst/best case time of its header multiplied by (number of iterations + 1) plus
the worst/best case time of the body multiplied by the number of iterations.
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Self-loop: a loop where the header and body are the same. It is therefore
considered to have a minimum loop count of 1. This roughly corresponds to
high level code structures such as do loops. The worst/best case time for a
self-loop is determined by the worst/best case time of its body multiplied up
buy the number of iterations.

Function: is the high-level construct of the function and consists of a list of other
structural nodes. The worst/best case time for a function is calculated in the
same way as that of a sequence.

14.4.3 Identifying nodes: code references

A code reference is the way to specify a particular location in an application. A
code reference is made up of a base and an optional backtrail. The base consists
of a reference type and the backtrail consists of a comma separated list of
reference types

There are a number of different reference types, all of which map to one or more
instruction program counters (PCs). This will usually be one PC, but can be more
than one due to compiler optimizations or because the user has explicitly named
multiple instructions with the same reference. Compiler optimizations such as
inlining or unrolling will result in the same reference mapping to multiple PCs.

The different reference types are detailed below. The commands to list the in-
stances of them for the currently loaded executable in the console are detailed
with each type.

Source file-line references are valid for source lines which the compiler has
defined as belonging to a source-level basic block. The valid lines can be listed
in the console using:

list allsrclabels

Source labels are added to source code using the #pragma xta label. To list
the source labels in the console, type:

list srclabels

Call file-line references are valid for source lines which map to function calls.
To list the valid source lines in the console, type:

list allcalls

Call labels are added to source code using the #pragma xta call. To list the
source labels in the console, type:

list calls

Endpoint file-line references are available for source lines which map to a valid
endpoint. To list the endpoints in the console type:

list allendpoints
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Endpoint labels are added to the source using #pragma xta endpoint. They
must be on the line before an input/output operation. To list the labeled
endpoints in the console, type:

list endpoints

Labels are arbitrary text strings referring to any source or assembly label. To
list the labels in the console, type:

list labels

Labels in assembly must be within an executable section.

Functions are the functions contained within the binary. To list the labels in the
console, type:

list functions

Functions in assembler must be labeled as functions with the .type directive to
be correctly detected by the XTA (see xTIMEcomposer Studio User Guide). They
must also be within an executable section.

Program counters (PC) are the lowest-level reference, giving a hexadecimal pro-
gram counter value starting with 0x. They must map to the PC of an instruction
within the executable section of the program.

14.4.4 Reference Classes

Particular console commands only work on particular types of references. The sets
of reference types that are defined for a particular command are know as reference
classes.

ENDPOINT: A reference that can be used for timing. This means any reference
in assembler (PC/label) and only source references which map to lines which
can be reliably used for timing. Compiler optimizations cannot remove them
or re-order them with respect to each other. In XC code these correspond to
source lines with 1/0 operations. The following console command lists the types
available in the class:

help ENDPOINT
CALL: References that map to function calls. These are used in back trails to

identify unique instances of a code reference. The following console command
lists the types available in the class:

help CALL

FUNCTION: References that map to functions. The following console command
lists the types available in the class:

help FUNCTION

LABEL: The following console command lists the types available in the class:
help LABEL

PC: The following console command lists the types available in the class:
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Figure 23:

Using

backtrails.

help PC

It is possible to have a code reference which could map to multiple types. For
example there could be an endpoint which has been given the same name as a
function in the program. The way a reference in a backtrail is matched can depend
upon the type of the reference. To resolve this potential ambiguity, it is possible
to force the code reference to a certain type by prefixing with its type.

14.4.5 Back trails

A code reference’s base may occur multiple times within a program. For example,
a function can be called from multiple places. The back trail for a reference is
a way of restricting a reference to specific instances. Consider the example file
shown in Figure 23.

1 void delay_n_seconds ( int j) {

2 for ( unsigned int i = 0; i < j; ++i) {
3 # pragma xta label " delay_loop "
4 delay_1_second ();

5 }

6 1}

7

8 int test () {

9 # pragma xta call " delay_1 "

10 delay_n_seconds (10);

11 # pragma xta call " delay_2 "

12 delay_n_seconds (20);

13 return O;

14 }

The following commands could be used to time the test function:
analyze function test
set loop - delay_loop 10

That would have the effect of setting the number of loop iterations for the loop in
both instances of the delay_n_seconds to 10. However, as the number of iterations
are passed as a parameter to delay_n_seconds, the value is different for each call.

To time test correctly the loop iterations for each instance needs to be specified
differently. This can be achieved by the use of the call references and backtrails.
For example:

analyze function test

set loop - delay_1,delay_loop 10

set loop - delay_2,delay_loop 20
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This tells the tool to set delay_loop to 10 iterations when called from delay_1, and
to 20 iterations when called from delay_2. The references used in the above case
are composed of a base reference of type source label, and a backtrial or size one,
of type call label. The above can also be achieved using the file-line equivalents.
For example:

analyze function test
set loop - source.xc:10,source.xc:3 10
set loop - source.xc:12,source.xc:3 20

However, this would not result in a portable and robust script implementation, so
using file-line references in this way from a script is not encouraged.

When the compiler inlines some code (for example the delay_n_seconds function
above) then some references will no longer be valid. In this case the following
reference would not exist because the call no longer exists:

source .xc:10, source.xc:3

However, if the call has been labeled with a call label, the compiler ensures that
the reference is still valid even if the code is inlined. So, in the above case, the
following reference will still be valid;

delay_1,delay_loop

14.4.6 Scope of references

References can have either global or local scope. Globally scoped references are
those which apply to (or get resolved on) the global tree. The global tree is the
notional structural representation of the whole program, prior to any route analysis
taking place. Locally scoped references are those which apply to (or get resolved
on) a user created route tree. Whether a particular reference is globally of locally
scoped depends on the command being executed. The following commands used
globally scoped references:

analyze path
analyze function
analyze loop
add exclusion
add branch
The following commands used locally scoped references:
set/add loop

set/add looppath
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set/add loopscope
set/add instructiontime
set/add pathtime
set/add functiontime

In general, globally scoped references can lead to multiple route creation.

14.5 Automating the process

The XTA can be automated to ensure that new versions of an application meet
timing requirements using a script.

14.5.1 Writing a script

The script file is a sequence of XTA console commands. Each one on a separate
line. Any line starting with the # symbol is considered a comment.

Developers must insert pragmas into the source code where required to make the
script portable. If the script creation process modifies the source (e.g. by inserting
pragmas) the relevant binary must be rebuilt before the script can be successfully
executed.

It is recommended not to put a load or exit command in the script. These
commands should be done at the time of calling the script.

XTA scripts must use the .xta extension in order to be used by the compiler and
understood correctly by xTIMEcomposer Studio.

14.5.2 Running a script

Scripts can be run in different ways, either in xTIMEcomposer Studio or on the
command-line.

During compilation: On the command line the .xta scripts must be passed to
the compiler manually. By default, timing failures are treated as warnings and
syntax errors in the script as errors.

To treat timing failures as errors, add the following to the compiler arguments:
-Werror=timing

To treat script syntax errors as warnings, add the following to the compiler
arguments:

-Wno-error=timing-syntax
Batch mode: In batch mode the XTA takes command-line arguments and inter-

prets them as XTA commands. For example, to run an XTA script (script.xta)
on a binary (test.xe) use:

xta -load test.xe -source script.xta -exit
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Note: the ‘-’ character is used as a separator between commands.

14.5.3 Embedding commands into source

The XTA can embed commands into source code using a command pragma. For
example,

#pragma xta command "print summary"

All commands embedded into the source are run every time the binary is loaded
into the XTA. Commands are executed in the order they occur in the file, but the
order between commands in different source files is not defined.

Pragmas are only supported in XC code.

14.6 Scripting XTA via the Jython interface

Figure 24:

Example of
an XTA

Jython script.

The XTA supports scripts written using the Jython language (an implementation
of Python running on the Java virtual machine). XTA Jython scripts must have the
extension .py. They can be executed in the same way as command based XTA
scripts. From within Jython, XTA features are made available though the globally
accessible xta object. See Figure 24 for an example script. This scripts loads the
binary test.xe into the XTA and analyzes the function functionName. It then sets
a loop count on each of the resulting routes and finally, prints the best and worst
case times for each.

import sys
import java

try
xta . load (" test .xe");
except java . lang . Exception , e:
print e. getMessage ()
try
ids = xta . analyzeFunction (" functionName ");
for id in ids :
xta . setLoop (id , " loopReference ", 10)
for id in ids :
print xta . getRouteDescription (id),
print xta . getWorstCase (id , "mns"),
print xta . getBestCase (id , "ns")
except java . lang . Exception , e:

print e. getMessage ()
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IN THIS CHAPTER
Commands
Pragmas
Timing Modes
Loop Scopes
Reference Classes
XTA Jython interface

Code reference grammar

This chapter lists all the commands and options supported by the XTA, reference classes, and a
reference to the grammar.

15.1 Commands

15.1.1 add

Function add branch <from BRANCH> [<to INSTRUCTION>]+
Description | Adds the given from/to references to the branches list

Type add branch <from BRANCH> [<to INSTRUCTION>]+

Function add tile <tile id|*>
Description | Add xCORE tile to active set

Type add tile <tile id|#*>

Function add exclusion <ANY>
Description | Adds the given reference to the list of exclusions

Type add exclusion <ANY>
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Function add functiontime <FUNCTION> <value> <MODE>

Description | Adds the given function time to the list of defines

Type add functiontime <FUNCTION> <value> <MODE>

Function add instructiontime <ENDPOINT> <value> <MODE>
Description | Adds the given instruction time to the list of defines

Type add instructiontime <ENDPOINT> <value> <MODE>

Function add loop <ANY> <iterations>

Description | Adds the given loop count define to the list of defines

Type add loop <ANY> <iterations>

Function add looppath <ANY> <iterations>

Description | Adds the given loop path count define to the list of defines
Type add looppath <ANY> <iterations>

Function add loopscope <ANY> <SCOPE>

Description | Adds the given loop scope define to the list of defines

Type add loopscope <ANY> <SCOPE>

Function add pathtime <from ENDPOINT> <to ENDPOINT> <value> <MODE>
Description | Adds the given path time to the list of defines

Type add pathtime <from ENDPOINT> <to ENDPOINT> <value> <MODE>
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15.1.2 analyze

Function analyze endpoints <from ENDPOINT> <to ENDPOINT>
Description | Analyzes between the specified endpoints
Type analyze endpoints <from ENDPOINT> <to ENDPOINT>
Function analyze function <FUNCTION>
Description | Analyzes the given function
Type analyze function <FUNCTION>
Function analyze loop <ANY>
Description | Analyzes the given loop
Type analyze loop <ANY>
15.1.3 config
Function config case <best/worst>
Description | Sets the case (currently: worst)
Type config case <best/worst>
Function config Ewarning <on/off>
Description | Treats errors as warnings or not (currently: off)
Type config Ewarning <on/off>
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Function config freq <node id> <tile frequency>

Description | Sets the operating frequency in MHz for the given node
Type config freq <node id> <tile frequency>

Function config from <ENDPOINT>

Description | Sets the from endpoint

Type config from <ENDPOINT>

Function config looppoint <ANY>

Description | Sets the loop point

Type config looppoint <ANY>

Function config scale <true/false>

Description | Configures whether results are scales (currently: true)
Type config scale <true/false>

Function config srcpaths <paths>

Description | Sets the (semicolon separated) source search path
Type config srcpaths <paths>

Function config cores <tile id> <num cores>

Description | Sets number of cores currently executing for the given tile
Type config cores <tile id> <num cores>
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Function config timeout <seconds>
Description | Sets the tools timeout on load
Type config timeout <seconds>
Function config Terror <on/off>
Description | Treat timing failures as errors or not (currently: on)
Type config Terror <on/off>
Function config to <ENDPOINT>
Description | Sets the to endpoint
Type config to <ENDPOINT>
Function config verbosity <level>
Description | Sets the tool verbosity level (range: -10 -> +10, default: 0)
Type config verbosity <level>
Function config Werror <on/off>
Description | Treats warnings as errors or not (currently: off)
Type config Werror <on/off>
15.1.4 clear
Function clear
Description | Clears the screen (GUI mode only)
Type clear()
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15.1.5 debug

Function dumpactiveexclusions

Description | Dumps a list of PCs that the exclusions have resolved to

Type debug dumpactiveexclusions()

Function debug dumpcachedfunction <FUNCTION>

Description | Dumps the cached function structure

Type debug dumpcachedfunction <FUNCTION>

Function dumpcallgraph

Description | Dumps the call graph for all tiles in dot (graphviz) format

Type debug dumpcallgraph()

Function debug dumpcontrolflow <FUNCTION>

Description | Dumps the control flow graph for the given function in dot (graphviz) format
Type debug dumpcontrolflow <FUNCTION>

Function dumpmanual

Description | Dumps the console reference chapter of the manual in tex format
Type debug dumpmanual ()

Function debug dumpstacknodes <REFERENCE>

Description | Dumps the stack nodes for the given reference

Type debug dumpstacknodes <REFERENCE>
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Function dumpunresolvedinstructions

Description | Dumps a list of instructions that are unresolved

Type debug dumpunresolvedinstructions()

Function debug verifyreference <ANY>

Description | Verifies the existance of the given reference

Type debug verifyreference <ANY>

Function frompoints

Description | Displays the from endpoints currently configured

Type debug frompoints()

Function topoints

Description | Displays the to endpoints currently configured

Type debug topoints()

Function debug instructiontime <route id> <node id>

Description | Displays the instruction time set for the given node in the given route
Type debug instructiontime <route id> <node id>

Function debug loop <route id> <node id>

Description | Displays the loop iterations set for the given node in the given route
Type debug loop <route id> <node id>
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Function debug looppath <route id> <node id>

Description | Displays the loop path iterations set for the given node in the given route
Type debug looppath <route id> <node id>

Function debug loopscope <route id> <node id>

Description | Displays the loop scope set for the given node in the given route

Type debug loopscope <route id> <node id>

Function debug listglobalreferences <ANY>

Description | Lists all the matching references for the given reference on the global tree
Type debug listglobalreferences <ANY>

Function debug listroutereferences <route id> <ANY>

Description | Lists all the matching references for the given reference on the given route
Type debug listroutereferences <route id> <ANY>

Function memusage

Description | Displays the current memory usage for the JVM

Type debug memusage ()

Function getmemthreshold

Description | Displays the current memory usage threshold

Type debug getmemthreshold()
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Function debug setmemthreshold <threshold>
Description | Sets the memory threshold to the given value (0.0 - 1.0)
Type debug setmemthreshold <threshold>

15.1.6 echo
Function echo "text"
Description | Prints the text to the console
Type echo "text"

15.1.7 exit
Function exit
Description | Quits the application
Type exit ()

15.1.8 help
Function help [command|command subcommand|option]
Description | Displays help message for the given arguments
Type help [command|command subcommand|option]

15.1.9 history

Function history
Description | Displays the command history
Type history()
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15.1.10 load
Function load <xe file>
Description | Loads the given XMOS executable file
Type load <xe file>
15.1.11 list
Function allcalls
Description | Lists all the possible locations for calls
Type list allcalls()
Function allendpoints
Description | Lists all the possible locations for endpoints
Type list allendpoints()
Function list branches [route id]
Description | Lists the branches - optionally for the specified route
Type list branches [route id]
Function calls
Description | Lists the calls
Type list calls()
Function tiles
Description | Lists the active xCORE tiles

Continued on next page
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Type list tiles()

Function endpoints

Description | Lists the endpoints

Type list endpoints()

Function list exclusions [route id]

Description | Displays the exclusions - optionally for the specified route
Type list exclusions [route id]

Function functions

Description | Lists the functions in the loaded application
Type list functions()

Function functiontimes

Description | Displays the function time defines

Type list functiontimes()

Function instructiontimes

Description | Displays the instruction time defines

Type list instructiontimes()
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Function list knowns <route id>
Description | Displays the list of knowns set for the given route
Type list knowns <route id>
Function labels

Description | Lists the labels

Type list labels()

Function loops

Description | Displays the loop defines

Type list loops()

Function looppaths

Description | Displays the loop path defines
Type list looppaths()

Function loopscopes

Description | Displays the loop scope defines
Type list loopscopes()

Function pathtimes

Description | Displays the path time defines
Type list pathtimes()
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Function sources

Description | Lists the source files

Type list sources()

Function srccommands

Description | Displays the command list embedded in the loaded executable
Type list srccommands()

Function srcloops

Description | Displays the loop counts embedded in the loaded executable
Type list srcloops()

Function srclabels

Description | Lists the source labels

Type list srclabels()

Function allsrclabels

Description | Lists all the possible locations for source labels

Type list allsrclabels()

Function corestartpoints

Description | Lists the logical core start points

Type list corestartpoints()
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Function corestoppoints
Description | Lists the logical core stop points
Type list corestoppoints()
Function list unknowns <route id>
Description | Displays the list of unknowns for the given route
Type list unknowns <route id>
15.1.12 print
Function summary
Description | Shows routes summary (verbosity -2|-1]|0)
Type print summary()
Function print structure <route id> [node id]
Description | Displays the structure for given route/node (verbosity 0[1)
Type print structure <route id> [node id]
Function print asm <route id> [node id]
Description | Displays annotated assembly for the given route/node
Type print asm <route id> [node id]
Function print src <route id> [node id]
Description | Displays annotated source file(s) for given route/node
Type print src <route id> [node id]
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Function print trace <route id> [node id]
Description | Displays instruction trace for the worst case path of the given route/node
Type print trace <route id> [node id]
Function print routeinfo <route id>
Description | Shows detailed information for the given route
Type print routeinfo <route id>
Function print nodeinfo <route id> <node id>
Description | Shows detailed information for the given node in the given route
Type print nodeinfo <route id> <node id>
Function warnings
Description | Prints all timing warnings
Type print warnings()
Function print distribution <route id> [node id]
Description | Displays time distribution for the given route/node
Type print distribution <route id> [node id]
15.1.13 pwd
Function pwd
Description | Displays the current working directory
Type pwd ()
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15.1.14 remove

Function remove branch <from BRANCH|*> [<to INSTRUCTION|*>]+
Description | Removes the given from/to references from the branches list
Type remove branch <from BRANCH|*> [<to INSTRUCTION|*>]+
Function remove tile <tile id|*>

Description | Removes xCORE tile from active set

Type remove tile <tile id|*>

Function remove exclusion <ANY/|*>

Description | Removes the given reference (or all if ‘*’) from the list of exclusions
Type remove exclusion <ANY|*>

Function remove functiontime <FUNCTION|*>

Description | Removes the given functon time from the list of defines
Type remove functiontime <FUNCTION|*>

Function remove instructiontime <ENDPOINT|*>

Description | Removes the given instruction time from the list of defines
Type remove instructiontime <ENDPOINT|=*>

Function remove loop <ANY/[*>

Description | Removes the given loop count define to the list of defines
Type remove loop <ANY|*>
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Function remove looppath <ANY/[*>

Description | Removes the given loop path count define to the list of defines
Type remove looppath <ANY|x*>

Function remove loopscope <ANY/|*>

Description | Removes the given loop scope define to the list of defines
Type remove loopscope <ANY|*>

Function remove pathtime <from ENDPOINT|*> <to ENDPOINT]|*>
Description | Removes the given path time from the list of defines

Type remove pathtime <from ENDPOINT|#*> <to ENDPOINT|*>
Function remove route <route id>

Description | Removes the route with the given id from the current analysis
Type remove route <route id>

15.1.15 scripter

Function scripter disable <ANY>

Description | Disables a mapping

Type scripter disable <ANY>

Function dump

Description | Dumps script which represents the current state - also embeds active pragmas
into source

Continued on next page
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Type scripter dump()

Function scripter embed <filename>

Description | Embeds the script into the designated file - also embed active pragmas into
source

Type scripter embed <filename>

Function scripter enable <ANY>

Description | Enables a mapping

Type scripter enable <ANY>

Function listrefs

Description | Lists all references which will be used in the script

Type scripter listrefs()

Function scripter rename <ANY> <TO_NAME>
Description | Renames a mapping

Type scripter rename <ANY> <TO_NAME>
15.1.16 set
Function set exclusion <route id> <ANY>

Description | Sets an exclusion on the given reference

Type set exclusion <route id> <ANY>
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Function set functiontime <route id> <FUNCTION> <value> <MODE>

Description | Sets timing requirement for the given function on the given route

Type set functiontime <route id> <FUNCTION> <value> <MODE>

Function set instructiontime <route id> <ENDPOINT> <value> <MODE>

Description | Sets the time taken for the instruction at the given pc

Type set instructiontime <route id> <ENDPOINT> <value> <MODE>

Function set loop <route id> <ANY> <iterations>

Description | Sets the number of iterations for the loop identified

Type set loop <route id> <ANY> <iterations>

Function set looppath <route id> <ANY> <iterations>

Description | Sets the number of iterations for the path identified

Type set looppath <route id> <ANY> <iterations>

Function set loopscope <route id> <ANY> <SCOPE>

Description | Sets the scope of the referenced loop

Type set loopscope <route id> <ANY> <SCOPE>

Function set pathtime <route id> <from ENDPOINT> <to ENDPOINT> <value>
<MODE>

Description | Sets timing requirement for the given path on the given route

Type set pathtime <route id> <from ENDPOINT> <to ENDPOINT> <value> <MODE>
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Function set required <route id> <value> <MODE>
Description | Sets the maximum allowed time taken for the given route
Type set required <route id> <value> <MODE>

15.1.17 source

Function source <file name> [args]
Description | Sources the given script file
Type source <file name> [args]

15.1.18 status

Function status
Description | Displays current status
Type status()

15.1.19 version

Function version
Description | Displays the version information
Type version()

15.2 Pragmas

Function #pragma xta label "name"
Description | Provides a label that can be used to specify timing constraints.
Type #pragma xta label "name"

XMO0980TA

XMOS



xTIMEcomposer User Guide for tools version 14.0.x

Function #pragma xta endpoint "name"

Description | Specifies an endpoint. It may appear before an input or output statement.

Type #pragma xta endpoint "name"

Function #pragma xta call "name"

Description | Defines a label for a (function) call point. Use to specify a particular called
instance of a function. For example, if a function contains a loop, the iterations
for this loop can be set to a different value depending on which call point the
function was called from.

Type #pragma xta call "name"

Function #pragma xta command "command"

Description | Allows XTA commands to be embedded into source code. All commands are
run every time the binary is loaded into the XTA. Commands are executed in
the order they occur in the file, but the order between commands in different
source files is not defined.

Type #pragma xta command "command"

Function #pragma xta loop "integer"

Description | Applies the given loop XTA iterations to the loop containing the pragma.

Type #pragma xta loop "integer"

15.3 Timing Modes

The available timing modes are:

Function ns
Description | nanoseconds
Type ns()
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Function us

Description | microseconds

Type us ()

Function ms

Description | milliseconds

Type ms ()

Function MHz

Description | megahertz

Type MHz ()

Function KHz

Description | kilohertz

Type KHz ()

Function Hz

Description | hertz

Type Hz ()

Function cycles

Description | The core cycle count is the number of scheduled slots that the logical core
required to perform the sequence. The relationship between core cycles and
time is a function of the number of cores currently running and the xCORE tile
frequency.

Continued on next page

XMO0980TA

XMOS



xTIMEcomposer User Guide for tools version 14.0.x

107/412

Type

cycles()

15.4 Loop Scopes

Supported values for scope are:

Function r

Description | Iteration number propagates to the enclosing path (Default)
Type relative/r ()

Function a

Description | Absolute number of iterations

Type absolute/a()

15.5 Reference Classes

15.5.1 FUNCTION

Function FunctionPc

Description | Raw program counter specified in the format: 0x*
Type FunctionPc()

Function Function

Description | Any function

Type Function()

15.5.2 BRANCH
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Function EndpointPC

Description | Raw program counter specified in the format: 0x*

Type EndpointPC()

Function CallPc

Description | Call specified in the format: 0x*

Type CallPc()

Function CallFileLine

Description | Call specified in the format: ‘file name:line number’

Type CallFileLine()

Function Call

Description | Call specified using the source level pragma mechanism

Type Call()

Function Label

Description | Any source or assembly level symbol defined with respect to an executable
section

Type Label ()

Function CallLabel

Description | Any source or assembly level symbol defined with respect to an executable
section

Type CallLabel()
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15.5.3 INSTRUCTION
Function EndpointPC
Description | Raw program counter specified in the format: 0x*
Type EndpointPC()
Function FunctionPc
Description | Raw program counter specified in the format: 0x*
Type FunctionPc ()
Function Function
Description | Any function
Type Function()
Function Label
Description | Any source or assembly level symbol defined with respect to an executable
section
Type Label()

15.5.4 ENDPOINT

Function EndpointPC
Description | Raw program counter specified in the format: 0x*
Type EndpointPC()

109/412
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Function EndpointFileLine

Description | Endpoint specified in the format: ‘file name:line number’

Type EndpointFileLine ()

Function Endpoint

Description | Endpoint specified using the source level pragma mechanism

Type Endpoint ()

Function CallPc

Description | Call specified in the format: 0x*

Type CallPc()

Function CallFileLine

Description | Call specified in the format: ‘file name:line number’

Type CallFileLine()

Function Call

Description | Call specified using the source level pragma mechanism

Type Call()

Function Label

Description | Any source or assembly level symbol defined with respect to an executable
section

Type Label ()
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Function CallLabel

Description | Any source or assembly level symbol defined with respect to an executable
section

Type CallLabel()

15.5.5 ANY

Function SrcLabelPc

Description | Raw program counter specified in the format: 0x*

Type SrcLabelPc()

Function EndpointPC

Description | Raw program counter specified in the format: 0x*

Type EndpointPC()

Function EndpointFileLine

Description | Endpoint specified in the format: ‘file name:line number’

Type EndpointFileLine ()

Function Endpoint

Description | Endpoint specified using the source level pragma mechanism

Type Endpoint ()

Function CallPc

Description | Call specified in the format: 0x*

Continued on next page
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Type CallPc()

Function CallFileLine

Description | Call specified in the format: ‘file name:line number’

Type CallFileLine()

Function Call

Description | Call specified using the source level pragma mechanism

Type Call()

Function SrcLabelFileLine

Description | Source label specified in the format: ‘file name:line number’

Type SrcLabelFileLine()

Function SrcLabel

Description | Source label specified using the source level pragma mechanism

Type SrcLabel ()

Function Label

Description | Any source or assembly level symbol defined with respect to an executable
section

Type Label ()
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Function CallLabel

Description | Any source or assembly level symbol defined with respect to an executable
section

Type CalllLabel ()

15.5.6 FUNCTION_WITH_EVERYTHING

Function EverythingReference

Description | Matches everything: “*’

Type EverythingReference ()

Function FunctionPc

Description | Raw program counter specified in the format: 0x*
Type FunctionPc()

Function Function

Description | Any function

Type Function()

15.5.7 BRANCH_WITH_EVERYTHING

Function EverythingReference
Description | Matches everything: ‘*’
Type EverythingReference ()
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Function EndpointPC

Description | Raw program counter specified in the format: 0x*

Type EndpointPC()

Function CallPc

Description | Call specified in the format: 0x*

Type CallPc()

Function CallFileLine

Description | Call specified in the format: ‘file name:line number’

Type CallFileLine()

Function Call

Description | Call specified using the source level pragma mechanism

Type Call()

Function Label

Description | Any source or assembly level symbol defined with respect to an executable
section

Type Label ()

Function CallLabel

Description | Any source or assembly level symbol defined with respect to an executable
section

Type CallLabel()
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15.5.8 INSTRUCTION_WITH_EVERYTHING

Function EverythingReference

Description | Matches everything: ‘*’

Type EverythingReference ()

Function EndpointPC

Description | Raw program counter specified in the format: 0x*

Type EndpointPC()

Function FunctionPc

Description | Raw program counter specified in the format: 0x*

Type FunctionPc()

Function Function

Description | Any function

Type Function()

Function Label

Description | Any source or assembly level symbol defined with respect to an executable
section

Type Label ()

15.5.9 ENDPOINT_WITH_EVERYTHING
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Function EverythingReference

Description | Matches everything: ‘*’

Type EverythingReference ()

Function EndpointPC

Description | Raw program counter specified in the format: 0x*

Type EndpointPC()

Function EndpointFileLine

Description | Endpoint specified in the format: ‘file name:line number’
Type EndpointFileLine ()

Function Endpoint

Description | Endpoint specified using the source level pragma mechanism
Type Endpoint ()

Function CallPc

Description | Call specified in the format: 0x*

Type CallPc()

Function CallFileLine

Description | Call specified in the format: ‘file name:line number’
Type CallFileLine()
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Function Call

Description | Call specified using the source level pragma mechanism

Type Call()

Function Label

Description | Any source or assembly level symbol defined with respect to an executable
section

Type Label()

Function CallLabel

Description | Any source or assembly level symbol defined with respect to an executable
section

Type CalllLabel()

15.5.10 ANY_WITH_EVERYTHING

Function EverythingReference

Description | Matches everything: ‘*’

Type EverythingReference ()

Function SrcLabelPc

Description | Raw program counter specified in the format: 0x*
Type SrcLabelPc()
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Function EndpointPC

Description | Raw program counter specified in the format: 0x*

Type EndpointPC()

Function EndpointFileLine

Description | Endpoint specified in the format: ‘file name:line number’
Type EndpointFileLine ()

Function Endpoint

Description | Endpoint specified using the source level pragma mechanism
Type Endpoint ()

Function CallPc

Description | Call specified in the format: 0x*

Type CallPc()

Function CallFileLine

Description | Call specified in the format: ‘file name:line number’
Type CallFileLine()

Function Call

Description | Call specified using the source level pragma mechanism
Type Call()
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Function SrcLabelFileLine

Description | Source label specified in the format: ‘file name:line number’

Type SrcLabelFileLine()

Function SrcLabel

Description | Source label specified using the source level pragma mechanism

Type SrcLabel ()

Function Label

Description | Any source or assembly level symbol defined with respect to an executable
section

Type Label()

Function CallLabel

Description | Any source or assembly level symbol defined with respect to an executable
section

Type CalllLabel ()

15.6 XTA Jython interface

The Jython interface to the global xta object is as follows:

15.6.1

Load methods

void load(String fileName) throws Exception

15.6.2 Route creation/deletion methods

List<Integer> analyzeFunction(String functionName) throws Exception
List<Integer> analyzeEndpoints(String fromRef, String toRef) throws Exception
List<Integer> analyzeLoop(String loopRef) throws Exception

void removeRoute(int routeId) throws Exception
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15.6.3 Add/remove methods

void addTile(String tileReference) throws Exception
void removeTile(String tileReference) throws Exception
Collection<String> getTiles() throws Exception

void addExclusion(String ref) throws Exception
void removeExclusion(String ref) throws Exception
Collection<String> getExclusions() throws Exception

void addBranch(String fromRefString, Collection<String> toRefStrings)
throws Exception

void removeBranch(String fromRefString, Collection<String> toRefStrings)
throws Exception

Collection<String> getBranches() throws Exception

Collection<String> getBranchTargets(String branch) throws Exception

void addLoop(String ref, long iterations) throws Exception
void removeLoop(String ref) throws Exception
Collection<String> getLoops() throws Exception

void addLoopPath(String ref, long iterations) throws Exception
void removeLoopPath(String ref) throws Exception
Collection<String> getLoopPaths() throws Exception

void addLoopScope(String ref, boolean absolute) throws Exception
void removeLoopScope(String ref) throws Exception
Collection<String> getLoopScopes() throws Exception

void addInstructionTime(String ref, double value, String units)
throws Exception

void removeInstructionTime(String ref) throws Exception
Collection<String> getInstructionTimes() throws Exception

void addFunctionTime(String ref, double value, String units)
throws Exception

void removeFunctionTime(String ref) throws Exception
Collection<String> getFunctionTimes() throws Exception

void addPathTime(String fromRef, String toRef, double value, String units)
throws Exception

void removePathTime(String fromRef, String toRef) throws Exception
Collection<String> getPathTimes() throws Exception

15.6.4 Set methods

void setRequired(int routeld, double value, String units) throws Exception
void setFunctionTime(int routeIld, String refString, double value,

String units) throws Exception

void setPathTime(int routeld, String fromRef, String toRef, double value,
String units) throws Exception

void setInstructionTime(int routeld, String refString, double value,
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String units) throws Exception

void setLoop(int routelId, String refString, long iterations)
throws Exception

void setLoopPath(int routeld, String refString, long iterations)
throws Exception

void setLoopScope(int routeld, String refString, boolean absolute)
throws Exception

void setExclusion(int routeld, String refString) throws Exception

15.6.5 Get methods

double getRequired(int routeld, String units) throws Exception
double getWorstCase(int routeId, String units) throws Exception
double getBestCase(int routeld, String units) throws Exception
List<String> getWarnings(int routeld) throws Exception
List<String> getErrors(int routeId) throws Exception

List<Integer> getRouteIds() String getRouteDescription(int routeId)
throws Exception

15.6.6 Config methods
void configCores(String tileReference, int numCores) throws Exception
void configFreq(String nodelId, double tileFrequency) throws Exception
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15.7 Code reference grammar

A code reference constructed of a back trail and a base reference of the form:

code-ref

back-trail

base-ref

pc-ref
label-ref

function-ref

endpoint-ref

srclabel-ref

call-ref

pc-class

label-class

functionclass

endpointclass

srclabelclass

back-trail base-ref

base-ref

base-ref ,

pc-ref
label-ref

back-trail

function-ref
endpoint-ref
srclabel-ref

call-ref

pc-class hex-constant

label-class label-string

function-class function-name
function-class hex-constant

endpoint-class file-line

endpoint-class endpoint-label
endpoint-class hex-constant

srclabel-class label-string

call-class label-string

call-class hex-constant

PC:

LABEL:

FUNCTION:

ENDPOINT:

SRCLABEL:
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call-class =
| CALL:

file-line == file-name : integer-constant
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16Use xTIMEcomposer to run a program

IN THIS CHAPTER

Create a Run Configuration

Re-run a program

16.1

xTIMEcomposer uses Run Configurations to determine the settings used to run a
program. Run Configurations are specific to the project and target platform.

Create a Run Configuration

To create a Run Configuration, follow these steps:

1.
2.

7.

Select a project in the Project Explorer.

Choose Run » Run Configurations.

. In the left panel, double-click XCore Application.

xTIMEcomposer creates a new configuration and displays the default settings in
the right panel, as shown in Figure 25.

. In Name, enter a name for the configuration.

. XTIMEcomposer tries to identify the target project and executable for you. To

select one yourself, click Browse to the right of the Project text box and select
your project in the Project Selection dialog box. Then click Search Project and
select the executable file in the Program Selection dialog box.

You must have previously compiled your program without any errors for the
executable to be available for selection.

. If you have a development board connected to your system, check the hardware

option and select your debug adapter from the Target list. Alternatively, check
the simulator option to run your program on the XMOS simulator.

Click Run.

XTIMEcomposer loads your executable, displaying any output generated by your
program in the Console.
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Name: vMyProject Debug

/D Main N\ B Simulatoﬂ XScope] ()= Argumentsw ) En\fironmenq = Common]

Project:

‘MyProject | | Browse.. |

Build configuration: | Debug =

C/C++ Application:

bin/Debug/MyProject_Debug.xe | Search Project... | | Browse.. |
Device options:

Run on: |‘» simulator @hardware

Target: | XMOS XTAG-2 connected to L1(0..1) [u2BZNn_8) | | Refresh list |

1/O options:

(®) Run JTAG 1/0 server

() Run UART output server
() Run XScope output server
Azivanced options:

| | Enable GPROF collection

| | Change JTAG TCK divider (default = 0)

XTAG-1 (6/(<n>+1)MHz) <> XTAG-2 (25/(<n>+2)MH2)

F|gure_25: Additional xrun command line options
Run Configu-
ration . .
. | | Display run command in new console
window =

16.2 Re-run a program

XTIMEcomposer remembers the configuration last used to run your program. To
run it again using the same configuration, just click the Run button. To use a
different configuration, click the arrow to the right of the Run button and select a
configuration from the drop-down list.
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IN THIS CHAPTER
Overall Options
Target Options
Debugging Options
xSCOPE Options

XRUN loads and runs XMOS Executable (XE) files on target hardware. It requires either the XMOS or
FTDI USB-to-JTAG drivers to be installed, depending on the adapter used with the target hardware
(see §2).

17.1 Overall Options

The following options are used to specify an executable to run and, optionally, an xCORE tile on
which to run the program.

xe-file Specifies an XE file to load and run.

--verbose Prints information about the program loaded onto the target devices.
--help Prints a description of the supported command line options.
--version Displays the version number and copyrights.

17.2 Target Options

The following options are used to specify a target hardware platform.
--list-devices

-1 Prints an enumerated list of all JTAG adapters connected to the host and the devices
on each JTAG chain, in the form:

ID Name Adapter ID Devices

The adapters are ordered by their serial numbers.
--list-board-info
-1b Displays information about the connected target board.

--id ID Specifies the adapter connected to the target hardware.

--adapter-id ADAPTER-SERIAL-NUMBER
Specifies the serial number of the adapter connected to the target hardware.
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--jtag-speed n

--noreset

Sets the divider for the JTAG clock to n. If unspecified, the default value is 0. The
maximum value is 70.

For FTDI-based debug adapters, the JTAG clock speed is set to 6/(n+1)MHz.
For XMOS-based debug adapters, the JTAG clock speed is set to 25/(n+1)MHz.

Does not reset the XMOS devices on the JTAG scan chain before loading the
program. This is not default.

17.3 Debugging Options

The following options are used to enable debugging capabilities.

--io

--uart

--attach

--dump-state

Causes XRUN to remain attached to the JTAG adapter after loading the program,
enabling system calls with the host. XRUN terminates when the program calls exit.

By default, XRUN disconnects from the JTAG adapter once the program is loaded.
Enables a UART server that interfaces with the UART-to-USB converter on the XMOS
USB-to-JTAG adapters. The converter operates at a rate of 115200 bits/sec.

The USB-to-UART converter on XMOS adapter interfaces with two pins on the XSYS
connector that, on XMOS development boards, are connected to ports on an XMOS
device. The ports are named in the XN files as PORT_UART_TX and PORT_UART_RX.

This option is not supported for adapters based on FTDI chips.

Attaches to a JTAG adapter (of a running program), enabling system calls with the
host. XRUN terminates when the program performs a call to exit.

An XE file must be specified with this option.

Prints the core, register and stack contents of all xCORE Tiles in JTAG scan chain.
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17.4 xSCOPE Options

The following options are used to enable xSCOPE capabilities.
--xscope Enables an xXSCOPE server with the target.

--Xxscope-realtime
Enables an xSCOPE server with the target using a socket connection.

--xscope-file filename
Specifies the filename for xSCOPE data collection.

--xscope-port ip:port
Specifies the IP address and port for realtime data capture.

--xscope-limit limit
Specifies the record limit for xSCOPE data collection.
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18Use xTIMEcomposer and xSCOPE to trace data in real-time

IN THIS CHAPTER

XN File Configuration

Instrument a program

Configure and run a program with tracing enabled

Analyze data offline

Analyze data in real-time

Trace using the UART interface

xTIMEcomposer and the xSCOPE library let you instrument your program with
probes that collect application data in real-time. This data can be sent over an
XTAG-2 debug adapter to xTIMEcomposer for real-time display or written to a file
for offline analysis.

-
O Target Hardware Platform O XTIMEcomposer
SOFTWARE SCOPE
IRERTERRRRENATT!
(T
3 ! dE xConnect Links 5 ; m ‘-
4 Instrumente; 3 ransfer
1 Software [ XSYS —> Buffer 1 UsB
Figure 26: E
xSCOPE
connectivity
\O o ) ¢ >

If you are using a legacy FTDI or XTAG-1 debug adapter, or if the XSYS connector
on your target hardware does not provide an xCONNECT Link, you can configure
the probes to output trace data over your adapter’s UART interface instead (see XM-
000957-PC). Note that the UART interface is supported on a single tile only and
offers significantly reduced performance.

If your hardware requires an xTAG adapter board (XA-SK-XTAG2) to connect the
XTAG, the XMOS LINK switch on the adapter board must be set to ON to use
XxSCOPE.

18.1 XN File Configuration

To allow the tools to configure the xCONNECT link required for high speed data
collection using xscope, the XN file for a board must be modified to expose the
connection to the XTAG-2 device. The following information must be added to the
links section of an XN file for a board to set up the link used by the target device
to communicate with the XTAG-2 and the xscope channel.
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<Link Encoding="2wire" Delays="4,4" Flags="XSCOPE">
<LinkEndpoint NodeId="O" Link="XOLD"/>
<LinkEndpoint RoutingId="0x8000" Chanend="1"/>
</Link>

Note that when the link is set to 2 wire, the minimum delay is set to 4 and the flags
specify that this link is to be used for streaming debug. Setting the delay higher
results in the output of packets used by xscope being less frequent. The Routingld
is also important as the value 0x8000 specifies to the tools that this is a special
link used for xscope.

When used in a multi-tile system the Nodeld of the package which is connected to
the XSYS connector must be specified. The tools set up the links with the other tiles
but they need to know which specific device has the external link to be connected
to the XTAG-2.

18.2 Instrument a program

Figure 27:

Program that
traces input
levels to a
microphone

The example program in Figure 27 uses the xSCOPE instrumentation functions to
trace the input levels to a microphone.

#include <xscope.h>

port micL;
port micR;

void xscope_user_init(void) {
xscope_register (2,
XSCOPE_CONTINUQOUS, "Microphone Left", XSCOPE_UINT, "mV",
XSCOPE_CONTINUOUS, "Microphone Right", XSCOPE_UINT, "mV"
)
}

int main() {
while (1) {
int sample;
micl :> sample;
xscope_uint (0, sample);
micR :> sample;
xscope_uint (1, sample);

The constructor xscope_user_init registers two probes for tracing the left and
right inputs to a microphone. The probes are defined as continuous, which means
XTIMEcomposer can interpolate values between two subsequent measurements.
The probes are defined to take values of type unsigned int.

XMO0980TA

XMOS



xTIMEcomposer User Guide for tools version 14.0.x 133/412
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Figure 28:
Supported
probe types

In main, the program calls the probe function xscope_uint each time it samples
data from the microphone. This function creates a trace record and sends it to the
PC.

Figure 28 summarizes the different types of probes that can be configured. Only
continous probes can be displayed real-time.

Probe Type Data Type Scope View Example
XSCOPE_CONTINUQUS XSCOPE_UINT Line graph. May  Voltage levels of a motor
XSCOPE_INT be interpolated controller

XSCOPE_FLOAT

XSCOPE_DISCRETE XSCOPE_INT Horizontal lines  Buffer levels of audio
CODEC
XSCOPE_STATEMACHINE  XSCOPE_UINT State machine Progression of protocol
XSCOPE_STARTSTOP XSCOPE_NONE Start/stop bars Recorded function entry
XSCOPE_UINT and exit, with
XSCOPE_INT optional label value

XSCOPE_FLOAT

18.3 Configure and run a program with tracing enabled

Once you have instrumented your program, you must compile and link it with the
xSCOPE library, and run it in either offline or real-time mode.

To link with the xSCOPE library and run xSCOPE, follow these steps:
1. Open the Makefile for your project.

2. Locate the XCC_FLAGS_config variable for your build configuration, for example
XCC_FLAGS_Release.

3. Add the option -fxscope.
4. Create a Run Configuration for your target device (see §16.1).
5. Click the ** xSCOPE** tab and select Offline Mode to save data to a file for

offline analysis, or Real-Time Mode to output the data to the real-time viewer.

In offline mode, xTIMEcomposer logs trace data until program termination
and saves the traced data to the file xscope.xmt. To change, enter a filename
in the Output file text box. To limit the size of the trace file, enter a number
in the Limit records to text box.

In real-time mode, xTIMEcomposer opens the Scope view and displays an
animated view of the traced data as the program executes.

6. Click Run to save and run the configuration.
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18.4 Analyze data offline

Double-click a trace file in Project Explorer to open it in the Scope view, as shown
in Figure 29.
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Figure 29:

Offline Scope
view
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The top panel of the Scope view displays a graph of the data values for each
selected probe: the x-axis represents time (as per the timeline in the bottom panel)
and the y-axis represents the traced data values. The probes are grouped by their
assigned units, and multiple probes with the same unit can be overlaid onto a
single graph.

Moving the cursor over the s